
    

আ঳঳ারাভুয়ারাইকুভ। ভাইক্রা঳পট ওয়ার্ড-০৭ Tutorial টটক্ে আ঩নাক্ক স্বাগেভ। আ঩নাযা মাযা 

ভাইক্রা঳পট ওয়ার্ড-০৭ ট঱খক্ে চান োক্েয জনয ফইটট খুফই গুরুত্ব঩ূ্ড বফ  ফইটটক্ে খুফ ঳঴জ 

কক্য ওয়ার্ড বয কাজ গুক্রা টনক্য় ঳টচত্র আক্রাচনা কযা ঴ক্য়ক্ছ, আ঱া কটয ফইটট আ঩নাক্েয বাক্রা 

রাগক্ফ। ফইটট ঩ক্ে আ঩নাক্েয টফনু্দভাত্র উ঩কায ঴ক্র আভায ঩টযশ্রভ ঳ার্ডক ঴ক্ফ। আযও ফই 

প঩ক্ে আ঩টন আভায ব্লগ পেখক্ে ঩াক্যন- http://hiractg.blogspot.com 

ভাইনুর ঴ক ট঴যা 

ই-পভইরঃ hira_ctg28@yahoo.com 

ওক্য়ফ঳াইটঃ http://hiractg.blogspot.com 

আ঩নায ঳ুটফধায জনয টনক্চ ইনক্র্ক্স বয ভে ফইক্য়য ভূর Topics গুরা পেওয়া ঴র বফ  আ঩টন 

পমই Topics ব পমক্ে চান প঳ই Topics বয উ঩য টিক কযক্র আ঩টন প঳খাক্ন চক্র মাক্ফন। 

(বখাক্ন ঳ফ topics পেওয়া ঴য় নাই শুধু Important topics পেওয়া ঴র)   

Topics 

 Introduction 

 Home Tab 

a) Font Menu – MS Word keyboard Shortcut 

b) Paragraph related Toolbar 

c) Styles Tool 

d) Clipboard & Editing 

 Page Layout Tab 

a) Themes Menu 

b) Page Setup Menu 
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c) Page Background 

d) Paragraph section 

 View Tab 

a) Zoom Menu 

b) Window Menu 

 Insert Tab(Most Important) 

a) Create New Page 

b) Create cover page 

c) Create Table 

d) Insert Picture & Picture Editing 

e) Clip Art 

f) Text Toolbar 

g) Word Art 

h) Header & Footer Menu 

i) Create Logo With Shape & Word Art 

j) Equation Menu 

k) Chart Menu 

l) Smart Art Menu 

শুরু কযা মাক ো঴ক্র...  

Microsoft বয Office package টা আ঳ক্রই Complete বকটা package। মায ভাধযক্ভ প্রায় 
঳ফ ধযক্নয অটপট঱য়ার ফা দেনটন্দন কাজ কযা মায়। আ঩নায মাযা ওয়ার্ড ঩াক্যন োযা জাক্নন পম, 
ওয়ার্ড ফযফ঴ায কক্য ওক্য়ফ঳াইট দেযী কযা মায়। বছাোও logo, poster, banner, visiting 
card ইেযাটে design কযা মায়। ঳ুন্দয ঳ুন্দয Report দেযী কযা মায়, পমখাক্ন আ঩টন আ঩নায 
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ইচ্ছাভে Chart, Graphics বগুক্রা ঳ ক্মাজন কযক্ে ঩াযক্ফন বফ  আযও কে টক।বই 
টটউক্টাটযয়ারটা নেুন ফা মাযা ওয়ার্ড জাক্নন োক্েয জনয না। েক্ফ আটভ পচষ্টা কযফ, আ঩নাক্েয 
জানায টবেক্যও, টকছু অজানা ের্য পেয়ায। আয বটা ছাোও আ঩নাক্েয মটে অনয টকছু জানায 
র্াক্ক, ো঴ক্র আভাক্ক ইক্ভইর কযক্ে ঩াক্যন। ো঴ক্র আ঳ুন আয কর্া না ফাটেক্য়, শুরু কটয।  

আয বকটট কর্া MS Word-07 বফ  MS Word-10 প্রায় বকই ধযক্নয ইন্টাযক্প঳, বই কাযক্ন 
মাযা MS Word-07 বার ঩াযক্ফন োযা MS Word-10 ও ঩াযক্ফন।  

প্রর্ক্ভ ওয়ার্ড run করুন। ো঴ক্র বযকভ বকটট Screen পেখক্ে ঩াক্ফন। 

 

ছটফক্ে পম টুরফাযগুক্রা পেখক্ছন Home Tab ফা Home Menu বয Underব বগুক্রা ঳ফই খুফই 
েযকাযী। বখাক্ন পম টুরফায গুক্রা আক্ছ বগুক্রা ফযফ঴ায কক্যই আ঩টন ওয়ার্ড-বয প্রায় প্রক্য়াজনীয় 
঳ফ কাজই কযক্ে ঩াযক্ফন। োই আভযা প্রর্ক্ভই বই টুর঳ গুক্রা ফযফ঴ায কযা ট঱খফ। 
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আটভ বখাক্ন প্রর্ক্ভ ঳কর টুর঳ফায গুক্রায ছটফ টেফ োয঩য টনক্ছ ঳ফগুক্রা টনক্য় ফ্ডনা ফা বয 
কাজ গুক্রা পেখাফ। 
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বখাক্ন আভাক্েয ঳ফক্চক্য় প্রক্য়াজনীয় টুর঳ ঴ক্রা Font োয঩য Paragraph, Clipboard, 
Editing বফ  ঳ফক্঱ক্ল Styles টুরফাযটট। অক্নক্ক অফ঱য আভায ঳াক্র্ বকভে নাও ঴ক্ে ঩াক্যন। hira
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আ঩টন মটে computerব নেুন ঴ন ো঴ক্র অফ঱য আ঩নায ভক্ন প্রশ্ন আ঳ক্ে ঩াক্য Font টক? 
Font আ঳ক্র বক প঳ট ফ্ডভারা। ঳঴জ বাক্ফ ফরা মায়, ধরুন আ঩নায ৩জন ফনু্ধ আক্ছ – ট঴যা, 
আযভান, আট঳প। ো঴ক্র আভযা ঳াধায্ে বটা ফরক্ে ঩াটয পম, আ঩নায ৩ ফনু্ধয ঴াক্েয পরখা ৩ 
যকভ। কাক্যাযটা পেখক্ে খাযা঩, আফায কাক্যাযটা পেখক্ে বার, আফায কাক্যাযটা অক্নক প঩চাক্না 
অর্ডাৎ বক্ককজক্নযটা বক্কক ধযক্নয ঳ুন্দয। আ঩নায মটে ট঴যায ঴াক্েয পরখা বাক্রা রাক্গ, 
ো঴ক্র আ঩টন টক কযক্ফন প্রক্য়াজনীয় পকান টকছু পরখায ঳ভয় ট঴যাক্ক ফরক্ফন, ফনু্ধ আভাক্ক বইটা 
বকটু টরক্খ োও। আভযা font পক আ঳ক্র বক বকজক্নয ঴াক্েয পরখায ঳াক্র্ েুরনা কযক্ে 
঩াটয। কটিউটাক্য টফটবন্ন ধযক্নয font ফা ঴াক্েয পরখা, আ঩নায পম fontটট বার রাগক্ফ, আ঩টন 
প঳ই font টট ফযফ঴ায কযক্ফন। 
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প্রর্ক্ভই Fonts toolbar টটয ফযফ঴ায পজক্ন টনই। বখাক্ন আ঩নাযা টফটবন্ন টুর঳ বয আইকক্নয 
টেক্ক রক্ষ কযক্রন পেখক্ফন icon গুক্রা োক্েয ফযফ঴ায অনুমায়ী টর্জাইন কযা ঴ক্য়ক্ছ। পমভন 
Bold বয icon টায B বকটু পভাটা ঴যক্প পরখা আক্ছ, Italic আইকক্নয I টা র্ানটেক্ক কাে 
কযা, ববাক্ফ আ঩নাযা আইকন পেক্খই ফুঝক্ে ঩াযক্ফন ঐ Tools বয কাজ টক ইেযাটে। 
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঩ছন্দ অনুমায়ী Font টনফডাচন করুন। 
পন্ট ঳াইজ পছাট ফা ফে করুন। 
পন্টক্ক পফাল্ট ফা ঴াইরাইট করুন। 
পন্টক্ক ইটাটরক ফা র্ানটেক্ক ঴ারকা কাে কক্য টেন। 

 

পন্টক্ক আন্ডাযরাইন করুন। 
পন্ট বয ভাঝফযাফয োগ টেন। 
পন্টক্ক Subscript ফা H2O বই বাক্ফ টরখুন। 
পন্টক্ক Superscript ফা X2 ববাক্ফ টরখুন। 
টফটবন্ন ঱ব্দক্ক ফে ঴াক্েয ফা পছাট ঴াক্েয অক্ষক্য ঩টয্ে করুন। 
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বেক্ষ্ আভযা মা মা টরখরাভ প঳টা Save কযক্ে জাক্নন পো, না জানক্র ঳ভ঳যা পনই আ঳ুন 
টকবাক্ফ Save কযক্ে ঴য় ো পেক্খ টনই। 

 
 
ছটফক্ে পেখাক্না স্থাক্ন টিক করুন অর্ফা ঳ফক্চক্য় ঳঴জ ঩দ্ধটে টক-পফার্ড পর্ক্ক Ctrl বফ  S 
বক঳াক্র্ চা঩ টেন। 

 
 
োয঩য বকটট File Name টেন ও Save ব Click করুন। বক঳াক্র্ চা঩ পেয়াক্ক ঳াধায্ে (ctrl 
+ S) ববাক্ফ প্রকা঱ কযা ঴য়। টকক্ফার্ড কভান্ড ভক্ন যাখায ঳঴জ ঩দ্ধটে ঴র, আ঩টন পম কাজটট 
কযক্ে চান োয প্রর্ভ অক্ষয বফ  ঳াক্র্ Ctrl চা঩ক্ে ঴ক্ফ। আ঩টন ওয়ার্ড ওক্঩ন কক্য keyboard 
পর্ক্ক Alt পপ্র঳ করুন আ঩টন টনক্চয ছটফয ভে পেখক্ফন  

hira
ctg

.blog
spot.

com



    

  

উ঩ক্যয ছটফ পর্ক্ক আভযা পেখক্েটছ আভযা মখন ওয়াক্র্ড Alt পপ্র঳ কটয েখন প঳ োয ঳ফ Alt 
঱টডকাট পেখাই, বখন আভযা পমভন Alt+H পপ্র঳ কযক্র Home tab চক্র আ঳ক্ফ আ঩টন পেখুন 
আক্঳ টকনা? ফাটকগুরা ো঴ক্র ফুঝক্েই ঩াযক্ছন। বখন আফায আভযা Alt+N (Insert Men) পপ্র঳ 
কযক্র টনক্চয ভে পেখাক্ফ  

 

উ঩ক্যয ছটফক্ে Insert Menu ঳ফ ঱টডকাট আক্ছ আ঩টন শুধু Alt+(আ঩নায কাটিে key) পপ্র঳ 
কযক্র ঴ক্ফ। বকটা টজটন঳ পখয়ার যাখক্ফন Alt+N বফ  Ctrl+N বকই টজটন঳ নই! আভযা উ঩ক্য 
Alt+N বয ফযফ঴ায পেক্খটছ বখন পেখফ Ctrl+N পমভন আ঩টন মটে বকটট New file খুরক্ে চান 
ো঴ক্র টকক্ফার্ড কভান্ড টক ঴ওয়া উটচৎ, ঴যা আ঩টন টিক ধক্যক্ছন Ctrl+N বফায Ctrl ঳ রান্ত  
আক্যা টকছু টকক্ফার্ড কভান্ড টনক্চ পেয়া ঴রঃ  
 

 Common tasks in Microsoft Office Word 

To do this Press 
Create a nonbreaking space. CTRL+SHIFT+SPACEBAR 
Create a nonbreaking hyphen. CTRL+HYPHEN 
Make letters bold. CTRL+B 
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Make letters italic. CTRL+I 
Make letters underline. CTRL+U 
Decrease font size one value. CTRL+SHIFT+< 
Increase font size one value. CTRL+SHIFT+> 
Decrease font size 1 point. CTRL+[ 
Increase font size 1 point. CTRL+] 
Remove paragraph or character formatting. CTRL+SPACEBAR 
Copy the selected text or object. CTRL+C 
Cut the selected text or object. CTRL+X 
Paste text or an object. CTRL+V 
Paste special CTRL+ALT+V 
Paste formatting only CTRL+SHIFT+V 
Undo the last action. CTRL+Z 
Redo the last action. CTRL+Y 
Open the Word Count dialog box. CTRL+SHIFT+G 
 

 Create, view, and save documents 

To do this Press 
Create a new document of the same type as the current or 
most recent document. 

CTRL+N 

Open a document. CTRL+O 
Close a document. CTRL+W 
Split the document window. ALT+CTRL+S 
Remove the document window split. ALT+SHIFT+C 
Save a document. CTRL+S 
 

 Find, replace, and browse through text 
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To do this Press 
Find text, formatting, and special items. CTRL+F 
Repeat find (after closing Find and Replace window). ALT+CTRL+Y 
Replace text, specific formatting, and special items. CTRL+H 
Go to a page, bookmark, footnote, table, comment, 
graphic, or other location. 

CTRL+G 

Switch between the last four places that you have 
edited. 

ALT+CTRL+Z 

Open a list of browse options. Press the arrow keys to 
select an option, and then press ENTER to browse 
through a document by using the selected option. 

ALT+CTRL+HOME 

Move to the previous edit location. CTRL+PAGE UP 
Move to the next edit location. CTRL+PAGE DOWN 

েক্ফ ঳ভ঳ভয়ই পম বই পটকটনক কাক্জ রাগক্ফ, ো ফরটছ না েক্ফ অটধকা ঱ ঳ভয়ই বটা কাক্জ 
রাগক্ফ। শুধু ভাইক্রা঳পট ওয়াক্র্ড না পম পকান ঳পটওয়যায ব টকক্ফার্ড কভান্ডগুক্রা ববাক্ফ প঳ট 
কযা।  

ওয়ার্ড কাজ কযায ঳ভয় বকটা কর্া ঳ফ঳ভয় ভক্ন যাখক্ে ঴য় আয প঳টা ঴র ট঳ক্রক্ট কযা। আ঩টন 
পম অ ঱টুকু টনক্য় কাজ কযক্ছন, প঳ই অ ক্঱ পকান ঩টযফেডন চাইক্র আ঩নাক্ক অফ঱যই প঳ই 
অ ঱টুকু ট঳ক্রক্ট কযক্ে ঴ক্ফ। অক্নক ঳ভয় পেখক্ফন আ঩টন পকান বকটট পরখা ঴য়ে Bold কযক্ে 
চাইক্ছন, টকন্তু ঴ক্চ্ছনা কায্ টকন্তু বকটাই আ঩টন পম অ ঱টুকু পফাল্ড কযক্ে চাইক্ছন ো ঳টিকবাক্ফ 
ট঳ক্রক্ট কক্যনটন। ধরুন, আ঩টন টরখক্ে চাক্চ্ছন Bangladesh is my motherland – বয টবেক্য 
Bangladesh কর্াটট Bold ঴ক্ফ, প঳ক্ক্ষক্ত্র অফ঱যই আ঩নাক্ক Bangladesh ঱ব্দটা ভাউ঳ টেক্য় 
ট঳ক্রক্ট কক্য টনক্ে ঴ক্ফ। আভযা Home Tab বয Underবয Paragraph related toolbar বয 
঳াক্র্ ঩টযটচে ঴ফ। ছটফ রক্ষয করুন 
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উ঩ক্যয ছটফক্ে পকান টুর঳ বয টক নাভ ো ঳ফই পেয়া আক্ছ। বখন টনক্চ বই টুর঳গুক্রায কাজ 
টক ও টকবাক্ফ ফযফ঴ায কযক্ে ঴য় ো পেয়া ঴র। বকটা কর্া আক্গও ফরটছ বখন আফাক্যা ফরটছ, 
আ঩নাযা মটে টফটবন্ন টুর঳ বয Icon গুক্রায টেক্ক পখয়ার কক্যন ো঴ক্র পেখক্ে ঩াক্ফন পম, 
আইক্কান বভনবাক্ফ দেযী কযা ঴ক্য়ক্ছ, মাক্ে আ঩টন icon পেখক্রই ঐ টুর঳ বয কাজগুক্রা ফুঝক্ে 
঩াক্যন। উ঩ক্যয ছটফয ফুক্রট ঩ক্য়ক্ন্টয আইকন বারবাক্ফ পেখুন ো঴ক্র পেখক্ফন প্রর্ভ আইকক্ন 
৩টা পপাটা পেয়া োয঩য ৩টা রাইন আক্ছ, োয অর্ড আভযা মটে পকান রাইন পকান টফক্঱ল টচহ্ন 
দ্বাযা টরখক্ে চাই। আফায Alignment আইকক্ন পেখুন বকটায ফাভ঩া঱ ঳ভান, বকটায র্ান঩া঱ 
঳ভান আয টভর্র বযারাইনক্ভক্ন্ট রাইন বয েুই ঩াক্঱ ঳ভ঩টযভান পাকা জায়গা র্াক্ক। 

Bullet Point: পকান টফক্঱ল টচহ্ন দ্বাযা পকান ফাকয টরখক্ে চাইক্র ফা ঩ক্য়ন্ট আকাক্য পকান ফাকয 
টরখক্ে ঴ক্র। Bullet point ফযফ঴ায কযা মায়। নাম্বায দ্বাযাও ফুক্রট ঩ক্য়ক্ন্ট পেয়া মায়। বটা 
ফযফ঴ায কযায জনয প্রর্ক্ভ বই আইকক্ন টিক কযক্ে ঴য়, প্রর্ভ রাইন প঱ক্ল Enter চা঩ টেক্র 
঩যফেডী রাইন ও ফুক্রট ঩ক্য়ন্ট টেক্য় শুরু ঴ক্ফ। আয ঩য঩য ২ ফায Enter press কযক্র। ফুক্রট 
঩ক্য়ন্ট প঱ল ঴ক্য় মায়। আফায ফুক্রট ঩ক্য়ক্ন্টয পরখায ভক্ধয মটে ফুক্রট ছাো পকান রাইন টরখক্ে 
঴য়, ো঴ক্র ঳াধায্ে Shift+Enter বক঳াক্র্ চা঩ক্ে ঴য়। hira
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Indent: ঩ুক্যা para ধক্য র্াক্ন অর্ফা ফাক্ভ ঳যাক্নায জনয ফযফহৃে ঴য়। 

Alignment: র্াক্ন, ফাক্ভ ও ভাক্ঝ বযারাইক্ভন্ট কযায জনয ফযফ঴ায কযা ঴য়। 

Line & Character spacing: ঩য঩য েুই রাইন অর্ফা েুইটা ঱ব্দবয ভাক্ঝ কেটুকু পাকা জায়গা 
র্াকক্ফ, ো টনধায্ কযা ঴য়। 
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Background color & Border: প্রর্ক্ভ পম পরখায ফযাকগ্রাউন্ড ঩টযফেডন কযক্ে চান। ো ট঳ক্রক্ট 
করুন। োয঩য কারায ঩টযফেডন কক্য টেন। অনুরূ঩বাক্ফ পরখায Border ও পচঞ্জ কযক্ে ঩াক্যন। 
উো঴য্ স্বরূ঩ ছটফ রক্ষয কযক্ে ঩াক্যন। 

বফায Clipboard ও Editing বয টুর঳ গুক্রা টনক্য় আক্রাচনা কযফ। বই টুরগুক্রা ঳যা঳টয 
পরখাক্রটখয পক্ষক্ত্র পেভন বকটা কাক্জ রাক্গনা, টকন্তু আ঩টন মটে বই টুরগুক্রা ঳ুন্দয বাক্ফ ফযফ঴ায 
কযক্ে ঩াক্যন ো঴ক্র আ঩নাক্েয কাজ অক্নক কক্ভ মাক্ফ। 

 

Cut > বটা টেক্য় ঳াধাযনে পম পকান পরখা বকস্থান পর্ক্ক অনযস্থাক্ন কাট কক্য টনক্য় মাওয়া ঴য়। 
বয টকক্ফার্ড কভান্ড (Ctrl + X)। (অপটট঩ক: বটায টকক্ফার্ড কভান্ড টকন্তু ঴ওয়া উটচৎ টছর Ctrl+C 
টকন্তু ো না ঴ক্য় Ctrl+X ঴ক্য়ক্ছ। মটে ভক্ন র্াক্ক ো঴ক্র পেখক্ফন Ctrl+C টকক্ফার্ড কভান্ডটট আক্গই 
Copy েখর কক্য ফক্঳ আক্ছ। পমক্঴েু, বকই টকক্ফার্ড কভান্ড ঴ক্ে ঩াক্যনা, োই Ctrl+X ঴ক্য়ক্ছ। 
আফায রক্ষ করুন ঳াধাযনে আভযা কাটাকাটট কাাঁটচ টেক্য় কটয, কাাঁটচ টকন্তু পেখক্ে বকেভ ই যাজী 
অক্ষয X বয ভে পেখক্ে, োই বয টকক্ফার্ড কভান্ড Ctrl+X ঴ক্য়ক্ছ। বাফক্েই অফাক রাক্গ পম, 
টকক্ফার্ড কভান্ডগুক্রা বে ঳ুন্দয system অনুমায়ী ঴ক্য়ক্ছ পম, প্রক্য়াজনীয় টকক্ফার্ড কভান্ড গুক্রা 
বভটনই ভক্ন র্াক্ক। ) hira
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Copy > বটা টেক্য় পম পকান পরখা বকস্থান পর্ক্ক অনয স্থাক্ন Duplicate কযা ঴য়। keyboard 
কভান্ড Ctrl+C 
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Paste > বটা টেক্য় Cut/Copy কযা পকান পরখা পকান টনটেডষ্ট স্থাক্ন Paste ফা যাখা মায়। বয 
টকক্ফার্ড কভান্ড Ctrl+V। (অপটট঩ক: বখাক্ন বয প্রর্ভ অক্ষয P ঴ওয়া ঳ক্েও বয টকক্ফার্ড কভান্ড 
টকন্তু Ctrl+P না কায্ Ctrl+P পে Print নাভক খুফই প্রক্য়াজনীয় টকক্ফার্ড কভান্ড পেয়া আক্ছ। 
পেখুন টকক্ফার্ড বয X, C বয ঩ক্যয অক্ষযটাই V। বটা বক্েয ঩ক্য পেওয়াক্ে আভযা টকক্ফার্ড 
পর্ক্ক আঙু্গর না ঳টযক্য়ই খুফ ঳঴ক্জ বই অ঩঱নটা execute কযক্ে ঩াযফ। বটা পেখুন Ctrl+p পে 
পেয়া র্াকক্র আভাক্েয ঴াে উটিক্য় োয঩য কভান্ডটট টেক্ে ঴ক্ো। টক ইন্টাযটট  না – আভায কাক্ছ 
টকন্তু পছাটখাট ফযা঩াযগুক্রা খুফই বার রাক্গ। বই঳ফ পর্ক্ক পফাঝা মায় কটিউটায চারাক্না আ঳ক্র 
খুফই ঳঴জ কাজ, আভযা পচষ্টা কটয না োই ঩াটযনা।) 

 
 
Format Painter > বটা টেক্য় পম পকান পরখায Style বক টিক্কই copy কযা মায় পমভন ছটফ 
রক্ষ করুন। 
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Editing tools টাও খুফই প্রক্য়াজনীয়। 
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বটা টেক্য় আভযা খুফ ঳঴ক্জই পরখায ভক্ধয পর্ক্ক desired word টট খুক্জ প঩ক্ে ঩াটয। আফায 
ইচ্ছা কযক্র বকটা ঱ব্দ ঩টযফেডন কক্য অনয ঱ব্দ ফট঳ক্য় টেক্ে ঩াটয পচাক্খয ঩রক্কই। বয টকক্ফার্ড 
কভান্ড Ctrl+F. 
 

 

 
পমভন আভযা মটে Digital Bangladesh Paragraph টাক্ক ঩টযফেডন কক্য Digital Dhaka পে 
঩টযফেডন কযক্ে চাই ো঴ক্র প্রটেটা ঱ব্দ আরাো আরাো কক্য ঩টযফেডন না কক্য Replace 
option ফযফ঴ায কক্য বকফাক্য বফ  পচাক্খয টনটভক্লই কাজটট কযক্ে ঩াটয। hira
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বটাক্ক আক্যা অক্নকবাক্ফ ফযফ঴ায কযা মায়। বটা আ঩নাযা পফয করুন। 
 

আভাক্েয বখক্না Styles নাভক টুর঳টা ফাটক আক্ছ। বটা আ঳ক্র খুফই প঳াজা। ওয়ার্ড ব পম পকান 
টকছু টরখুন, োয঩য পরখাটট ট঳ক্রক্ট কক্য Styles ব মান পেখক্ফন, আ঩নায পরখায পন্ট ঳াইজ, 
কারায ইেযাটে change ঴ক্য় পগক্ছ। 
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বখন আটভ আ঩নাক্েয জনয বকটা practice file টেফ। শুরু পর্ক্ক বখন ঩মডন্ত আ঩নাযা মটে বার 
কক্য Practice কক্যন, ো঴ক্র বটা আ঩নাযা অনায়াক্঳ কযক্ে ঩াযক্ফন। মটে আ঩নাযা ঐ file বয 
কাজগুক্রা বার বাক্ফ কযক্ে ঩াক্যন, ো঴ক্র ফুঝক্ফা আ঩নায বারবাক্ফ ফুঝক্ছন। আয মাযা কযক্ে 
঩াক্যনটন োক্েয আ঳ক্র আক্যা practice েযকায। 

প্রর্ক্ভই বখান পর্ক্ক Exercise files টা download কক্য টনন। 
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ছটফয টেক্ক রক্ষ করুন। হুফহু বযকভ পেখক্ে word ব বকটা file দেযী করুন। মটে ঳ভ঳যা না 
঴য়, ো঴ক্র পফাঝা মাক্ফ আ঩টন খুফই বার word ঩াক্যন। 

আয মাক্েয বকটু ঳ভ঳যা ঴ক্চ্ছ োযা বই ছটফটা পেখক্ে ঩াক্যন। বখন আ঱া কটয, আয পকান 
঳ভ঳যা ঴ক্ফ না। 
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মটে কাক্যা Replace অ ঱টা টনক্য় ঳ভ঳যা ঴য় ো঴ক্র োযা বই ছটফটা পেক্খ টনক্ে ঩াক্যন। hira
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ধরুন আ঩নায পকান ফে বকটা যচনা টরখক্ে ঴ক্ফ োক্ে ঴য় ৩০ ফায Bangladesh word টা 
আক্ছ, ইচ্ছা কযক্রই আ঩নাযা ফুটদ্ধ খাটটক্য় বখাক্ন Replace ফযফ঴ায কযক্ে ঩াক্যন। ঴য়ে 
আ঩নাযা পরখায ঳ভয় “bd” টরখক্রন, ঩যফেডীক্ে bd, replace কক্য Bangladesh কক্য টেক্রন। 
ববাক্ফ আ঩নাযা অক্নক ঳ভয় ফাাঁচাক্ে ঩াক্যন। বখনও মাযা কযক্ে ঩াযক্ছন না, োক্েয আক্যা পফট঱ 
practice েযকায। বার র্াকক্ফন। 
আয পকান ঳ভ঳যা ঴ক্র, অফ঱যই আভাক্ক জানাক্ফন।  

 

আ঱া কটয আ঩নাযা উ঩ক্যয practise টা বাক্রা কযক্ে প঩ক্যক্ছন ো঴ক্র বখন আভযা Page 
Layout Tab/Menubar বয tools গুক্রায কাজ পেখফ। বই টযাফ বয Margin, Page size 
printing বয জনয খুফই গুরুত্ব঩ূ্ড বই প঳ক঱নটা বারবাক্ফ পফাঝায পচষ্টা কযক্ফন। বই পভনুয 
প্রায় ঳ফ কাজই পভাটাভুটট ঳঴জ, আ঱া কটয বকফায প্রাকটট঳ কযক্রই ঴ক্য় মাক্ফ। েক্ফ Columns 
দেটয কযাটা বকটু বার কক্য পেখক্ফন কাযন বয টবেয বকটু জটটরো আক্ছ। করাভ দেটযয 
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কাজটা অফ঱য Table অ঩঱ন ফযফ঴ায কক্য খুফ ঳঴ক্জই কযা মায়। েক্ফ বই ট঳ক্টভটা আভযা 
মখন Insert পভনুয কাজ কযফ েখন পেখফ। আভযা অফ঱য Page layout বয ঳ফ অ঩঱ন 
পেখফনা, কাযন টকছু টজটন঳ পো আ঩নাক্েয জনয যাখক্ে ঴ক্ফ। টনক্চয ছটফটা রক্ষ করুন। ওয়ার্ড 
ওক্঩ন কযক্রই আ঩নাযা বভন পেখক্ে ঩াক্ফন। 

 

ছটফক্ে টফটবন্ন টুর঳গুক্রা রারকাটর টেক্য় আরাো কক্য পেখাক্না ঴ক্য়ক্ছ। বয ভক্ধয Themes, Page 
setup, Page background, Paragraph বফ  Arrange  নাভক section আক্ছ। আভযা বক্ক 
বক্ক প্রক্য়াজনীয় অ঩঱নগুক্রা পেখফ। পম অ঩঱নগুক্রা টনক্য় আটভ আক্রাচনা কযফ না প঳গুক্রা কষ্ট 
কক্য আ঩নাযা বকটু পেক্খ টনক্ফন। 
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প্রর্ক্ভই আভযা Themes নাভক অ঩঱নটা পেখফ। বটায আ঳ক্র নাভই বয কাজ ফক্র টেক্চ্ছ। 
বটাক্ক আ঩নাযা অক্নকটা Template বয ঳াক্র্ েুরনা কযক্ে ঩াক্যন। আভাক্েয ঩যাযায কারায, 
পন্ট বগুক্রা আক্গ পর্ক্ক আ঩টন define কক্য টেক্ে ঩াযক্ফন, োক্ে Document ফা আ঩নায দেটয 
পাইর বয টবেয Styles, fonts ঳ফটকছু টভক্র Harmony দেটয কযক্ফ। 
 

 
 

বফায ওয়াক্র্ড পম পকান টকছু পরক্খন োয঩য ছটফক্ে পেখাক্না স্থাক্ন ভাউ঳ ঩ক্য়ন্টায টনক্য় মান আয 
পেক্খন টকবাক্ফ আ঩নায পরখায style change ঴ক্য় মাক্চ্ছ। পমটা ঩ছন্দ ঴য় প঳টা ট঳ক্রক্ট করুন। 
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টর্ভ঳ বয ঩ক্যয tools টাই ঴র page setup বফ  বটা ওয়াক্র্ড টপ্রটন্ট  বয পক্ষক্ত্র খুফই গুরুত্ব঩ূ্ড 
বূটভকা ঩ারন কক্য। 

 

বই টুর঳ বয প্রর্ভ অ঩঱নটা ঴র margin। আভযা খাোয় ঳াধায্ে ফাক্ভ ও উ঩ক্যয অ ক্঱ 
ভাটজডন টেই, োয অর্ড ঴র টনটেডষ্ট টকছু জায়গা আভযা পরখায ঳ভয় কাগক্জয ফাক্ভ ও উ঩ক্য পাকা 
যাটখ, মাক্ে কক্য আভাক্েয পরখাটা পেখক্ে ঳ুন্দয পেখায়। আয আভযা কটিউটাক্য মখন ভাটজডন 
টেই , েখন ঳াধাযনে চায঩া঱ পর্ক্ক Box margin টেই। 
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 ভাটজডন পেয়ায জনয ভাটজডন ব টিক করুন োয঩য custom margin ব মান। hira
ctg
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আ঩নাযা টনক্জক্েয ইচ্ছাভে ভাটজডন টেক্ে চান েক্ফ ছটফক্ে পেখাক্না ঘক্য, ভানগুক্রা ঩টযফেডন কক্য 
টনন বফ  ঳ফক্঱ক্ল ok করুন। আ঱া কটয আ঩নাযা ভাটজডন টক বফ  বয কাজ টক ো ফুঝক্ে 
প঩ক্যক্ছন। 
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page orientation টক মটে না পজক্ন র্াকুন েক্ফ, ছটফক্ে রক্ষ করুন। বটট নাভ ঴র portrait 
ভুর্, বই ভুক্র্ র্াকক্র ঳াধাযনে আভযা পমবাক্ফ টপ্রন্ট কটয প঳বাক্ফই টপ্রন্ট ঴ক্ফ। 
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আয Landscape ভুক্র্ ঳াধাযনে কাগক্জয width পফট঱ বফ  height কভ র্াক্ক, টনক্চয ছটফয 
ভে।  

 

 

আভযা পমবাক্ফ margin টযাক্ফ টগক্য়টছরাভ টিক বকইবাক্ফ margin tab ব মান, োয঩য paper 
tab ব টিক করুন। বখাক্ন আ঩নায কাগক্জয ভা঩ টেক্ে ঴ক্ফ। বখাক্ন কাগক্জয ভা঩ মাই টেক্ফন 
প঳ই ভাক্঩য কাগক্জয উ঩য আ঩নায পরখাগুক্রা টপ্রন্ট ঴ক্ফ। hira
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঳াধায্ে আভযা A4 ঳াইক্জয কাগজ টনক্য় কাজ কটয। আ঩টন মটে কাগক্জয ভা঩ পেন ৮ইটি ফাই 
১০ইটি আয টপ্রন্টায মটে ৮ইটি ফাই ৮ইটিয বকটট কাগজ পেন েক্ফ ফুঝক্েই ঩াযক্ছন টক ঴ক্ফ, 
টক আয ঴ক্ফ টনক্চয পর্ক্ক ২ইটি ফাে ঩ক্ে মাক্ফ। োই ঳ফ঳ভয় টপ্রন্টাক্য পম ভাক্঩য কাগজ র্াকক্ফ 
বখাক্ন প঳ই বকই ভা঩ টেক্ফন। ভা঩ টনক্য় ঳ভ঳যা ঴ক্র Scale ফযফ঴ায করুন। 

 

বফায আভযা columns টনক্য় কাজ কযফ, বই টুর঳ গুক্রায ভক্ধয বই অ঩঱নটা বকটু জটটর। 
অক্নক ঳ভয় পেখা মায় আভাক্েয টফটবন্ন ধযক্নয ভযাগাটজক্নয ভে ২ করাভ ফা ৩ করাক্ভ পরখায 
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প্রক্য়াজন ঩ক্ে। প঳ক্ক্ষক্ত্র আভযা বই অ঩঱নটা ফযফ঴ায কযক্ে ঩াটয। করাভ কযায জনয ছটফক্ে 
পেখাক্না স্থাক্ন মান। 
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ো঴ক্র বভন পেখক্ে ঩াক্ফন। 
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বখাক্ন পেখুন আক্গ পর্ক্ক টকছু নভুনা দেটয কযা আক্ছ। আ঩নায প্রক্য়াজক্নয ঳াক্র্ মটে নভুনাগুক্রা 
ভযাচ কক্য, ো঴ক্র পম পকান বকটা ট঳ক্রক্ট করুন অনযর্ায় অনয বকটা অ঩঱ন ঩ছন্দ করুন। 
আ঩নায মটে ৪ করাক্ভয েযকায ঴য় ো঴ক্র Number of columns ঘক্য ৪ বটি করুন। 
করাক্ভয ভাক্ঝয পাাঁকা জায়গা কভাক্না ফাোক্নায জনয spacing বয ভান কটভক্য় ফাটেক্য় টেন। আয 
মটে প্রটেটা করাভ বয দেঘডয বকই না চান প঳ক্ক্ষক্ত্র Equal column width পর্ক্ক টটক টা উটিক্য় 
টেন। 

 

 
বখান আফায ছটফক্ে পেখাক্না স্থাক্ন অর্ডাৎ ১ভ ঩যাযায প঱ক্ল cursor যাখুন োয঩য 
Break > continuous ব মান। 
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ো঴ক্র বযকভ বকটা োগ পেখক্ে ঩াক্ফন, বই োগ পকন টেরাভ, বকটু ঩ক্যই জানক্ে ঩াযক্ফন। 
েক্ফ, বই dotted োগ গুক্রা টকন্তু টপ্রন্ট বয ঳ভয় আ঳ক্ফ না। বটা কাক্জয ঳ুটফধাক্র্ড ফা পফাঝায 
঳ুটফধাক্র্ড বই োগটা টেক্য় পনয়া মায়। ঳াধায্ে টর্পল্ট অফস্থায় বটা র্াক্কনা। মটে বই োগটা 
টেক্ে চান ো঴ক্র টনক্চয ছটফ ২টা রক্ষ করুন। 
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োয঩য আফায columns পর্ক্ক two ট঳ক্রক্ট করুন। 
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ো঴ক্র ছটফয ভে বাক্ফ পরখাগুক্রা ঴ক্য় মাক্ফ। প্রর্ক্ভ বককরাভ ও োয঩ক্য পরখাগুক্রা ২ করাক্ভ। 
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টনক্চয ছটফক্ে পেখাক্না রার যক্ঙয I বয স্থাক্ন কা঳ডয যাখুন। োয঩য 
Break > continuous। 
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ো঴ক্র আফায ২ করাক্ভয টনক্চ বকটট dotted line পেখা মাক্ফ। 

hira
ctg

.blog
spot.

com



    

 

োয঩য columns ব পমক্য় one ট঳ক্রক্ট করুন। 
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পরখাগুক্রা টনক্চয ভে ঳ুন্দয বাক্ফ ঳াটজক্য় গুটছক্য় আ঳ক্ফ। বই ধযক্নয পরখা পটটফর ফযফ঴ায কক্য 
easily কযা মায়, মা আভযা ঩যফেডীক্ে পেখফ। hira

ctg
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বখন line numbers পর্ক্ক ইচ্ছা কযক্র রাইন নাম্বায টেক্ে ঩াক্যন। 
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ছটফক্ে পেখাক্না স্থাক্ন মান বফ  Print preview mode select করুন। ো঴ক্র পেখক্ফন dotted 
line গুক্রা পেখা মাক্চ্ছ না। আয Print preview mode মা পেখা মাক্ফ শুধুভাত্র প঳গুক্রাই print 
঴ক্ফ অনয টকছু print ঴ক্ফনা। hira
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বখন আভযা Page Layout Menu বয Page Background নাভক অ঩঱নটা পেখফ। 
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উ঩ক্যয ছটফক্ে পেখুন টেনটা অ঩঱ন আক্ছ Watermark, Page Color ও Page Borders। বয 
ভক্ধয আভযা প্রর্ক্ভ watermark option টা পেখফ। বটায ঳াক্র্ কভক্ফট঱ আভযা ঳ফাই ঩টযটচে। 
পমভন আ঩টন বই ফইটটক্ে বকটট Watermark পেখক্ে ঩াযক্ছন। ঳াধায্ে বটা পকান প্রটেষ্ঠান 
ফা ফযটিয টনজস্বো পফাঝাক্ে ফা পকান ের্য বয কট঩ পযাধ কযক্ে বই অ঩঱নটট ফযফ঴ায কযা মায়। 
পমভন আভযা পেক্খটছ অক্নক পকাটচ  প঳ন্টায ফা টফটবন্ন ঳যাক্যয পনাক্টয টবেক্য বই ঳যাক্যয নাভ 
অর্ফা পকাটচ  প঳ন্টায নাভ র্াক্ক মাক্ে অনয পকউ বটাক্ক টনক্জয নাক্ভ চাটরক্য় টেক্ে না ঩াক্য। 
঳াধায্ে watermark ঴র Background ব পকান টফক্঱ল পটক্সট ফা ছটফ জরছা঩ ফা 
transparent বাক্ফ পেয়া। জরছা঩ পেয়ায জনয প্রর্ক্ভ আ঩টন Watermark menu পর্ক্ক 
Custom Watermark click করুন 
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োয঩য টনক্চয ভে পেখক্ে ঩াক্ফন। বখান পর্ক্ক প্রক্য়াজনীয় অ঩঱ন ট঳ক্রক্ট কক্য apply কক্য ok 
করুন। মটে পকান ছটফক্ক watermark ট঴ক্঳ক্ফ ফযফ঴ায কযক্ে চান ো঴ক্র ২য় অ঩঱ন ফাছাই 
করুন ও Select picture পর্ক্ক ছটফটট পেটখক্য় টেন। আয পকান পরখা ফা text পক watermark 
ট঴ক্঳ক্ফ চাইক্র, Text ঘক্য আ঩নায প্রক্য়াজনীয় পরখা টেন। বখাক্ন আটভ Do not copy টেক্য়টছ 
আ঩টন আ঩নায নাভ টেক্ে ঩াক্যন। Diagonal select কযক্র পরখাটট পকানাকুটন অর্ফা ক্ড ফযাফয 
঴ক্ফ আয Horizontal select কযক্র নযভাটর আভযা পমবাক্ফ টরটখ প঳ই বাক্ফ ঴ক্ফ টকন্তু বকটু ফে 
পক্ন্ট। hira
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Page border পেয়ায জনয বখান পর্ক্ক page border ব টিক করুন। 

 

োয঩য টনক্চয ছটফটট পেখুন বখাক্ন প্রক্য়াজনীয় ঳ফ অ঩঱ন ঩াক্ফন। 
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প঩ক্জয চায঩াক্঱ border টেক্ে চাইক্র Box select করুন। োয঩য border ট঴ক্঳ক্ফ রাইন টেক্ে 
চাইক্র style পর্ক্ক select করুন। color ও width প্রক্য়াজক্ন ঩টযফেডন কযক্ে ঩াক্যন। আয মটে 
বকটু অনয ধযক্নয border চান ো঴ক্র Art বয টবেয অক্নক ঳ুন্দয ঳ুন্দয ফর্ডায ঩াক্ফন, পমটা 
঩ছন্দ ঴ক্ফ প঳টাক্ে টিক কযক্রই ঴ক্ফ। আয র্ান ঩াক্঱ preview পেখক্ে ঩াক্ফন। ঳ফ঩াক্঱ ফর্ডায 
না চাইক্র বখান পর্ক্ক উটিক্য় টেক্ে ঩াক্যন, োয জনয ছটফক্ে পেখাক্না স্থাক্ন টিক কক্যন। ঳ফক্঱ক্ল 
Ok করুন।  
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আজ আভযা প঩জ পরআউট পভনুয paragraph setion পেখফ, বগুক্রা আ঳ক্র খুফই প঳াজা। ঳ফই 
পেয়া আক্ছ আ঩নাক্ক শুধু কষ্ট কক্য ভান ফট঳ক্য় টেক্ে ঴ক্ফ। টনক্চয ছটফক্ে রক্ষ করুন। আ঱া কটয 
ফুঝক্ে ঩াযক্ফন। 
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 Left Indent বয ভাধযক্ভ আ঩টন ফাভ ঩া঱ পর্ক্ক টনটেডষ্ট ঩টযভান জায়গা ছােক্ে ঩াক্যন। 
 Right Indent দ্বাযা আ঩টন অনুরূক্঩ র্ান ঩া঱ পর্ক্ক টনটেডষ্ট ঩টযভান জায়গা ছােক্ে ঩াক্যন। 
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 Before spacing দ্বাযা আ঩টন বকটট ঩যাযায উ঩ক্য কেটুকু পাকা যাখক্ফন ো টনটেডষ্ট কযক্ে 
঩াক্যন। 

 After spacing দ্বাযা আ঩টন বকটট ঩যাযায টনক্চ কেটুকু জায়গা পাকা যাখক্ফন ো ফক্র টেক্ে 
঩াক্যন। 

 
উ঩ক্যয ছটফয টেক্ক রক্ষ করুন বটা View পভনু। 
প্রর্ক্ভই আক্ছ Document View অ ঱ বয toolbar গুক্রা দ্বাযা আ঩টন টফটবন্ন view ট঳ক্রক্ট 
কযক্ে ঩াক্যন। েন্মক্ধয আ঩নায পম টবউ বার রাক্গ প঳ই টবউ টনক্য় আ঩টন কাজ কযক্ে ঩াক্যন। 
টনক্চয ছটফ পর্ক্ক পম পকান বকটা ট঳ক্রক্ট কক্য রক্ষ করুন। 

 

 

 
উ঩ক্যয ছটফক্ে রক্ষ করুন টফটবন্ন ধযক্নয অ঩঱ন আক্ছ মা দ্বাযা আ঩টন র্কুক্ভন্ট Ruler, 
Gridline ইেযাটে on off কযক্ে ঩াযক্ফন। বগুক্রা আ঩নাযা টনক্জযাই ফুঝক্ে ঩াযক্ফন।  
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উ঩ক্যয ছটফয টেক্ক রক্ষ করুন। বখাক্ন Zoom tools বয ঳া঴াক্ময আ঩টন ইচ্ছা ভে আ঩নায 
পরখা Text পক ফে অর্ফা পছাট কক্য পেখক্ে ঩াক্যন। বক্ে আ঩নায কাজ কযক্ে ঳ুটফধা ঴ক্ফ। 
ভক্ন যাখক্ফন পরখা zoom কযা আয পন্ট ঳াইজ ফে কযা টকন্তু বক কর্া নয়। কাযন আ঩টন মটে 
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Font size ফে কক্যন ো঴ক্র প঳টট printing বয ঳ভয়ও ফে আ঳ক্ফ টকন্তু মটে আ঩টন Zoom 
কক্যন ো঴ক্র বটা শুধু কটিউটায টিক্্ ফে পেখাক্ফ টকন্তু টপ্রটন্ট  বয ঳ভয় Font size পছাটই 
র্াকক্ফ। 

 
 
উ঩ক্যয ছটফক্ে পেখুন টফটবন্ন ধযক্নয জুভ বয অ঩঱ন আক্ছ পমভন ১০০, ২০০ ইেযাটে আফায 
আ঩টন আ঩নায ইচ্ছা ভে জুভ চাইক্র Percent ঘক্য টনটেডষ্ট বযারু put করুন। টনক্চ ছটফক্ে পেখুন 
১৫০% জুভ কযক্র পকভন পেখায়। 
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আফায পেখুন ২ প঩জ ট঳ক্রক্ট কযক্র আ঩নায প঩জ েুটা পকভন পেখাক্ফ। 

 
 
বখাক্ন আ঳ক্র আ঩নায প্রধান কাজ ঴র টফটবন্ন অ঩঱ন ট঳ক্রক্ট কক্য পেখা পকান অ঩঱নটা টকবাক্ফ 
কাজ কক্য ফা পকানটা ট঳ক্রক্ট কযক্র পকভন পেখায়। আ঩টন আ঩নায ঳ুটফধাভে বকটট অ঩঱ন 
ট঳ক্রক্ট করুন। 
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অক্নক ঳ভয় পেখা মায় আভাক্েয বকাটধক র্কুক্ভন্ট ফা ২-৩টা word file টনক্য় কাজ কযক্ে ঴য় 
প঳ক্ক্ষক্ত্র বই অ঩঱নগুক্রা খুফ কাক্জ পেয়। 

 

 
পমভন বখান পর্ক্ক আ঩টন মটে Arrange all select কক্যন আয আ঩নায মটে ২ টা ওয়ার্ড পাইর 
ওক্঩ন র্াক্ক ো঴ক্র টনক্চয ভে কক্য ঳াটজক্য় আ঳ক্ফ। 

 

 
আফায অক্নক ঳ভয় পেখা মায় বকই র্কুক্ভন্ট বয টফটবন্ন অ ঱ টনক্য় কাজ কযায েযকায ঴য় পমভন 
঴য়ে বকই পাইর বয ১ভ প঩জ ও ৩য় প঩জ টনক্য় বকই ঳াক্র্ কাজ কযায েযকায ঴য়, প঳ক্ক্ষক্ত্র 
Split অ঩঱নটা ফযফ঴ায কযায ভাধযক্ভ আ঩নায বই কাজটট কযক্ে ঩াক্যন। উ঩ক্যয অ ক্঱ মেটুকু 
঳ফ঳ভয় পেখায েযকায প঳টুকু ফাে পযক্খ টনক্চয পর্ক্ক split কক্যন ো঴ক্র টনক্চয অ ক্঱ অনয 
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পকান প঩ক্জয অনয পকান অ ঱ আনক্ে ঩াযক্ফন ফা উ঩ক্যয অ ক্঱ও অনয পকান অ ঱ পেখক্ে 
঩াযক্ফন। 

 

 
আফায view side by side select কযক্র টনক্চয ভে পেখা মাক্ফ। 
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বখন আভযা ms word বয খুফই গুরুত্ব঩ূ্ড বকটট পভনু ঳িডক্ক আক্রাচনা কযফ। আভায ভক্ে 
ওয়াক্র্ড Insert বফ  Format পভনু খুফই গুরুত্ব঩ূ্ড। কায্ বই েুই পভনুয ভাধযক্ভই ওয়াক্র্ডয 
অটধকা ঱ কাজ কযা মায়। আ঩নাযা মটে ওয়ার্ড প঱খায ঳ভয় menu গুক্রায নাক্ভয ফা রা অর্ড ভক্ন 
যাক্খন ো঴ক্র আ঩নাক্ক আয ভক্ন যাখক্ে ঴ক্ফ না পকান টজটন঳টা পকান পভনুক্ে আক্ছ। 
Insert বয ফা রা অর্ড আনা, প্রক্ফ঱ কযাক্না, পকান টকছুয টবেক্য স্থা঩ন কযা, ঳টন্নক্ফট঱ে কযা, 
প াকান ইেযাটে। 
Format বয ফা রা অর্ড ঴র টফনযা঳ কযা, প্রটরয়াজাে কযা ইেযাটে। 

টট঩঳: বখন ভক্ন করুন ওয়াক্র্ড আ঩টন বকটট পাকা প঩জ পমাগ কযক্ে চাক্চ্ছন ো঴ক্র বটা পকান 
পভনুক্ে র্াকা উটচৎ, আ঩নায কর্াটটক্কই ই যাজীক্ে ঩টয্ে করুন – পেখুন উত্তয প঩ক্য় মাক্ফন। 
পমাগ কযা অর্ড Insert আয পাকা প঩জ অর্ড Blank Page ো঴ক্র ঩ুযা কভান্ডটট োোর- Insert > 
Blank Page বখান আ঩টন ওয়ার্ড বয Insert পভনুক্ে মান পেক্খন বযকভ অর্ফা বয কাছাকাটছ 
synonym মুি পকান কভান্ড ঩াক্ফন। 
আফায ভক্ন কক্যন আ঩টন বকটট পটটফর পমাগ কযক্ে চাক্চ্ছন ো঴ক্র টক কভান্ড ঴ওয়া উটচৎ ফক্রন 
পো? 
঴যাাঁ ঳টিক ফক্রক্ছন পমাগ কযা অর্ড Insert বফ  পটটফর ই যাজী Table কাক্জই বটা ঴ক্ফ Insert 
পভনুয টবেক্য Table. ববাক্ফই আ঩টন টফটবন্ন কভান্ড পকান পভনুয টবেক্য আক্ছ ো ফুঝক্ে 
঩াযক্ফন। 

আ঳ুন টকছু Option বয কাজ পেক্খ পনয়া মাক। আ঩নাক্েয পেখায ঳ুটফধাক্র্ড আটভ Insert 
পভনুটাক্ক টনক্চ টনক্চ ঳াটজক্য় টেক্য়টছ। পভনুটায Icon গুক্রা বকনজয পেক্খ পনয়া মাক। োয঩যই 
আভযা আভাক্েয ভূর কাক্জ টপক্য মাফ। 
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ধরুন আভযা টনক্চয ভে বকটা প঩জ দেটয কক্যটছ। টকন্তু বই প঩ক্জয আক্গ বকটা পাকা প঩জ 
দেটয কযায েযকায – ো঴ক্র টকবাক্ফ দেটয কযক্ফন, প্রর্ক্ভ Mouse pointer প঩ক্জয বকেভ 
উ঩ক্য যাখুন োয঩য keyboard পর্ক্ক CTRL+Enter press করুন অর্ফা টনক্চয ছটফয টেক্ক রক্ষ 
করুন। 
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টনক্চয ছটফক্ে পেখাক্না স্থাক্ন টিক করুন ো঴ক্র নেুন বকটট প঩জ দেটয ঴ক্য় মাক্ফ। োয঩য বই 
প঩ক্জয আ঩নায মা খুট঱ োই প্রক্য়াজন ভে টরখক্ে ঩াক্যন। hira

ctg
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অক্নক ঳ভয় আভাক্েয টফটবন্ন কাক্জয প্রক্য়াজক্ন কবায প঩জ দেটয কযায েযকায ঩ক্ে। মটেও 
Blank page পর্ক্কই কবায প঩জ দেটয ঳ম্ভফ টকন্তু অক্নক্কই আক্ছন মাযা কবায প঩ক্জ টর্জাইন 
চান – আফায টনক্জ ঴য়ে অেটা বারবাক্ফ ওয়ার্ড চারাক্ে জাক্নন না, োক্েয ms word ব আক্গ 
পর্ক্ক অক্নক pre made design আক্ছ মায ভাধযক্ভ আ঩নাযা professional কবায প঩জ দেটয 
কযক্ে ঩াক্যন। আভযা মটে পকান assignment দেযী কযক্ে মাই েখন আভাক্েয ব঳ফ design 
অক্নক কাজ আ঳ক্ফ। 
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উ঩ক্যয ছটফ ভে কক্য কা঳ডয প঩ক্জয ঳ফায উ঩ক্য যাখুন োয঩য পম টর্জাইন ঩ছন্দ ঴য় প঳টা 
ট঳ক্রক্ট করুন। ো঴ক্র টনক্চয ছটফয ভে ট঳ক্রক্ট কযা cover টা পেখা মাক্ফ। বখন আ঩নায 
প্রক্য়াজন ভে নাভ, টাইক্টর বগুক্রা change কক্য টনন। 
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পটটফর দেটয কযায জনয টনক্চয ছটফয টেক্ক রক্ষ করুন। আ঩নায প্রক্য়াজনভক্ো Row ও Column 
ট঳ক্রক্ট কক্য ok করুন। ো঴ক্রই পটটফরটট দেটয ঴ক্য় মাক্ফ। 

 

঳াধায্ে ঳ফাই normal table দেযী কযক্ে ঩াক্য োই আটভ বকটট complex table দেযী 
কযফ। প্রর্ক্ভই চরুন পেটখ আভযা পম পটটফরটা দেটয কযফ, োয আউটরুক পকভন ঴ক্ফ: 

 

প্রর্ক্ভই Insert > Table পর্ক্ক টনক্চ ছটফক্ে পেখাক্না বাক্ফ ৬ করাভ ও ৫ পযা ট঳ক্রক্ট কটয। 
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পটটফর দেটয ঴ক্য় মাক্ফ। ছটফক্ে পেখাক্না (+) স্থাক্ন টিক কটয ঳িূ্ড পটটফর ট঳ক্রক্ট ঴ক্য় মাক্ফ। 

 
 
োয঩য ঐখাক্ন mouse পযক্খ Right click কটয, পম পভনু আ঳ক্ফ প঳খান পর্ক্ক borders and 
shading ব টিক কটয। 
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টনক্চয ভে বকটট উইক্ন্ডা আ঳ক্ফ, ছটফক্ে পেখাক্না বযারুগুক্রা ঩ুট কটয পমভন All select করুন, 
color change করুন ও ফর্ডায রাইন width ঩টযফেডন করুন। 
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আয র্ান ঩াক্঱ পেখুন Preview পেখা মাক্চ্ছ। আ঩টন মটে ঳ফ ঩াক্঱ ফর্ডায না চান ো঴ক্র বখান 
পর্ক্ক টফটবন্ন ঩াক্঱য ফর্ডায উটিক্য় টেক্ে ঩াক্যন বফ  Preview বয টেক্ক রক্ষ করুন, আ঳ক্র বটা 
পকভন ঴ক্রা। ঳ফক্঱ক্ল Ok করুন, ো঴ক্র আ঩নায পটটফরটট বভন ঴ক্ফ পেখক্ে। 

 

 
বখন টনক্চয ছটফক্ে পেখাক্না স্থাক্ন ভাউ঳ কা঳ডয টনক্য় মান বফ  টনক্চয টেক্ক Drag কক্য পটটফরটট 
ফে করুন। 

 
 
ো঴ক্র টনক্চয ভে বকটট পটটফর দেটয ঴ক্ফ। 
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প্রর্ভ ছটফক্ে রক্ষ করুন আভাক্েয প্রর্ভ পযা বয র্ান঩াক্঱ বকটা প঳র ও োয টনক্চ ৩ টা প঳র 
আক্ছ। বটা ফানাক্নায জনয আভযা প্রর্ক্ভই প্রর্ভ পযা বয প঱ক্লয ৩ টা প঳র ট঳ক্রক্ট কযফ, োয঩য 
right click কক্য Merge cells। 

 

 
 
টনক্চয ছটফয ভে বকটট পটটফর দেটয ঴ক্ফ। 

 
 
ঐ প঳ক্র কা঳ডয পযক্খ right click কটয, পম পভনু আ঳ক্ফ split cells পরখায উ঩য টিক কটয। 
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টনক্চয ভে পেখক্ে ঩াক্ফন, আফায আভযা পম পটটফরটা ফানাফ োয ছটফটা পেক্খ আ঳ুন। ওখাক্ন 
প্রর্ভ পযা বয প঱ক্ল ২টা পযা ও ৩টা করাভ আক্ছ। োই টনক্চয ভে উইক্ন্ডা আ঳ক্র করাভ ঘক্য ৩ 
ও পযা ঘক্য ২ ফ঳ান বফ  ওক্ক। 

 
 
টনক্চয ভে বকটট পটটফর ঩াক্ফন। 
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বখক্না আভাক্েয কাটিে পটটফক্রয ভে ঴য়টন, োই ছটফক্ে পেখাক্না ৩টা প঳র বকক্ত্র ট঳ক্রক্ট কক্য 
োয উ঩য right click কক্য, merge cells ব click করুন। 

 
 
ো঴ক্র টনক্চয ভে বকটট পটটফর ঩াক্ফন মা আভযা দেযী কযক্ে চাটচ্ছরাভ। hira
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বখন বয টবেক্য টকছু র্াটা ইন঩ুট করুন। প্রর্ভ পযা বয কারায ঩টযফেডন করুন ও পফাল্ড করুন। 
ো঴ক্র টনক্চয ভে বকটট পটটফর ঩াক্ফন। 

 
 
পটটফক্র বকটা বুর ঴ক্য় টগক্য়ক্ছ ঱াখা বয জনয যাখা করাভটা ও বকজন টুক্র্ন্ট বয নাভ টেক্ে 
বুর ঴ক্য় টগক্য়ক্ছ। আ঳ুন পেক্খ টনই টকবাক্ফ আভযা বটা পমাগ কক্য টেক্ে ঩াক্য। প্রর্ক্ভই নেুন 
টুক্র্ন্ট পমাগ কযায জনয বকেভ প঱ক্ল কা঳ডয টনক্য়, right click করুন ও insert ব মান বফ  
Insert Rows Below select কক্যন, ো঴ক্রই পেখক্ফন নেুন পযা add ঴ক্য় টগক্য়ক্ছ। hira
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নেুন row পে টনক্চয ভে টকছু ের্য ঩ূয্ করুন। 
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঱াখা Add কযায জনয পশ্রনী বয পম পকান cell বয কা঳ডয পযক্খ Right click করুন ও Insert 
পর্ক্ক Insert Columns Right select কক্যন, নেুন column add ঴ক্য় মাক্ফ। 

 
 
োয঩য উ঩ক্যয ছটফক্ে ভাকড কযা অ ক্঱ ভাউ঳ টনক্য় পগক্র কা঳ডয ঐযকভ টচক্হ্ন ঩টয্ে ঴ক্ফ, 
োয঩য ভাউ঳ ড্রাগ কক্য column বয width টা পছাট কক্য টেন বফ  পটটফরটা বকটু ফাক্ভ ভুব 
কযান ো঴ক্র টনক্চয ভে পেখক্ে ঴ক্ফ। 

 

 
বফায নেুন দেটয ঴ওয়া করাভ উ঩ক্যয ২ টা প঳র ভাজড কটয, বয জনয ২টা ট঳ক্রক্ট কক্য, যাইট 
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টিক কক্য Merge cells ব টিক কক্যন। ছটফয ভে। 
 

 

 
টনক্চয ছটফয ভে বকটট পটটফর দেটয ঴ক্ফ। 

 
 
আ঩নাক্েয জনয বকটা ফাটেয কাজ র্াকক্রা পেক্খন পো ঩াক্যন টকনা? টনক্চয ছটফয ভে বকটট 
পটটফর দেটয করুন। 
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আভযা বখন নেুন আক্যকটট table দেটয কযফ। টক দেটয কযক্ফা ো প্রর্ক্ভই বক নজয পেক্খ 
টনই। 

 

 
আ঱া কটয উ঩ক্য complex table ব পেখাক্না কাজ মাযা বারবাক্ফ ফুঝক্ে প঩ক্যক্ছন োযা খুফ 
঳঴ক্জই উ঩ক্যয পটটফরটা কযক্ে ঩াযক্ফন। বটা অফ঱য আভযা বকটু অনয উ঩াক্য়ও ফানাক্ে ঩াটয। 
প঳ক্ক্ষক্ত্র আভাক্েয গুক্ন টনক্ে ঴ক্ফ পম আভাক্েয প্রক্য়াজনীয় পটটফক্র ফা আভযা পম পটটফরটট ফানাফ 
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প঳টাক্ে কয়টা Row আক্ছ। পমভন উ঩ক্যয ছটফক্ে পেখুন Column বয ঳ খযা অ঳ভান টকন্তু Row 
বয ঳ খযা ঳ভান, োই প্রর্ক্ভ আভযা Insert > Table পর্ক্ক বকটা পটটফর কভান্ড টেফ মায Row 
5টা বফ  Column 1টা। ঩যফেডীক্ে আভযা করাক্ভয ঳ খযা টিক কক্য টনফ। ো঴ক্র আভযা বভন 
বকটা পটটফর ঩াফ মায row- ৫ টা ও column- ১ টা 

 
 
প্রর্ভ ১ভ Row পে ভাউ঳ ঩ক্য়ন্টায পযক্খ Right Click কক্য Split cells ব টিক কটয। 
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প্রর্ভ ছটফ পর্ক্ক পেক্খ টনই First row পে কয়টা করাভ আক্ছ, পম কয়টা প঳ কয়টা বই ঘক্য 
ফট঳ক্য় পেফ। োই আভযা বখাক্ন value ট঴ক্঳ক্ফ 3 টেক্য়টছ। 

 

ো঴ক্র আভযা টনক্চয ভে বকটট পটটফর ঩াফ। 

 

 
আফায ২য় পযাক্ে বকইবাক্ফ Right Click কক্য Split cells ব টিক কটয। 
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বখন পম উইক্ন্ডাটা আ঳ক্ফ বটায Column বয বযারু ট঴ক্঳ক্ফ ৪ put কটয বফ  ok কটয। 

 

 
ো঴ক্র টনক্চয ভে পেখক্ে বকটা পটটফর ঩াফ। 
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আভায টফশ্বা঳ আ঩নাযা মটে অনুরূ঩বাক্ফ ঳াভক্নয টেক্ক বটগক্য় মান ো঴ক্র আ঩নাযা টনক্চয ভে 
বকটট পটটফর খুফ ঳঴ক্জই ফানাক্ে ঩াযক্ফন। 

 

প্রর্ক্ভই 3 column ও 5 row টফট঱ষ্ট বকটট পটটফক্রয কভান্ড টেন। 
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োয঩য কাক্জয ঳ুটফধাক্র্ড আক্গ পেখাক্না টনয়ভানুমায়ী পটটফক্রয ফর্ডায বকটু Thick/পভাটা কক্য 
টেন, ো঴ক্র টনক্চয ভে বকটট পটটফর ঩াক্ফন। 

 
 
পটটফরটট ট঳ক্রক্ক্টর্ র্াকা অফস্থায় উ঩ক্যয পভনু ফায পর্ক্ক Design select করুন। 
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বফায টর্জাইন টুর঳ পর্ক্ক বকেভ প঱ক্লয Eraser টুর঳টা ট঳ক্রক্ট কক্য টেন। 

 
 
োয঩য টনক্চয ছটফয রার টচটহ্নে অ ক্঱ ভাউ঳ ঩ক্য়ন্টায টনক্য় মান বফ  টিক করুন। 
 

 
ো঴ক্র টনক্চয ভে বকটট পটটফর ঩াক্ফন। 
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আফায Design toolbar পর্ক্ক Draw Table select করুন। 

 
 
টনক্চয ছটফয রার টচটহ্নে স্থাক্ন ভাউ঳ ঩ক্য়ন্টায ড্রাগ করুন, ো঴ক্র পটটফক্র নেুন নেুন cell দেটয 
঴ক্ফ। 
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টনক্চয ভে বকটট পটটফর ঩াক্ফন 

 
 
বখন আফায টর্জাইন পভনুফায পর্ক্ক ভাকড কযা অ ক্঱ টিক করুন বফ  6pt select করুন। 
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টনক্চয ছটফক্ে পেখুন পম পম স্থাক্ন টিক কযা ঴ক্য়ক্ছ প঳ই প঳ই স্থাক্ন োগটা অনয োগগুক্রায পচক্য় 
পভাটা ঴ক্য় টগক্য়ক্ছ। 

 
 
আফায design পভনু পর্ক্ক Pen color tools ব টিক কক্য Light Blue কারাযটট ট঳ক্রক্ট কটয। hira
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োয঩য ছটফক্ে পেখাক্না স্থাক্ন টিক কযক্র ঐ স্থানগুক্রাও Light Blue color ঴ক্য় মাক্ফ। 

 
 
বফায Design menu বয Border অ ঱ পর্ক্ক টনক্চয ভে বকটট Line style select কটয বফ  
ো পটটফক্রয চায঩াক্঱ Outside border ট঴ক্঳ক্ফ ফযফ঴ায কটয। 
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ো঴ক্র টনক্চয ছটফয ভে চায঩াক্঱ ঳ুন্দয বকটা ফর্ডায প঩ক্য় মাফ। 
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আফায বকটা পটটফর দেটয কটয ৮পযা ও ১০করাভ টফট঱ষ্ট 

 
 
Design menu বয Table styles পর্ক্ক পম পকান বকটা টাইর ঩ছন্দভে ট঳ক্রক্ট কটয। ো঴ক্রই 
আভযা টনক্চয ভে বকটট পটটফর ঩াফ। 
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আ঱া কটয আ঩নাক্েয পটটফর টনক্য় আয পকান কাজই ঳ভ঳যা ঴ক্ফ না- মটে বকটু ফুটদ্ধ খাটাক্ে 
঩াক্যন। কায্ পভাটাভুটট বই কাজগুক্রা জানক্রই পম পকান ধযক্নয পটটফর ফানাক্না ঳ম্ভফ। 

আ঱া কটয আ঩নাক্েয ভক্ন আক্ছ, আ঩নাক্েয ফক্রটছরাভ পম করাক্ভয কাজটা Table টেক্য়ও কযা 
মায়, পমটা আটভ আ঩নাক্েয ঩ক্য পেখাফ। আ঩নাযা মটে পটটফর ফানাক্না বারবাক্ফ ট঱ক্খ র্াক্কন 
ো঴ক্র ঐ কাজটা পটটফর টেক্য় করুন। প্রর্ক্ভ পটটফর ফানান ঩যফেডীক্ে পটটফক্রয border 0 কক্য 
ো঴ক্রই ঴ক্য় মাক্ফ। 
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উ঩ক্যয ছটফটা পেক্খন আয আভাক্েয ঩ূক্ফডয কযা কাজটট বকই যকভ। উ঩ক্যয উো঴যন টকন্তু 
পটটফর টেক্য় দেটয, আ঩নায বটা Print Preview অফস্থায় পেখক্ছন। আয স্বাবাটফকবাক্ফ বটা 
বভন পেখাক্ফ। 
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ো঴ক্র পেটয না কক্য দেটয কক্য পপরুন। 

আয মাযা ঩াযক্ফন না োযা ঳াভক্ন পমক্কান বক জায়গায় বয ঳ভাধান প঩ক্য় মাক্ফন, টকন্তু ঳ফাই 
বকফায ঴ক্রও পচষ্টা কযক্ফন।   

 

বখন আ঩নাক্েয ঳াক্র্ Insert menu আযও ২টট গুরুত্ব঩ূ্ড অ঩঱ন টকবাক্ফ কাজ কক্য, ো 
পেখাফ। প্রর্ক্ভই Insert menu বয Picture ব টিক করুন। 
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ো঴ক্র টনক্চয ভে উইক্ন্ডা পেখক্ে ঩াক্ফন, বখান পর্ক্ক ঩ছক্ন্দয ছটফ ট঳ক্রক্ট কক্য Insert ব টিক 
করুন। 
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ো঴ক্রই পেখক্ফন ট঳ক্রক্ট কযা ছটফটট Word বয টবেক্য চক্র আ঳ক্ছ। 
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টকন্তু বখাক্ন বকটা ঳ভ঳যা আক্ছ, আয ো ঴র ছটফটা আ঩টন ইচ্ছাভে ঳যাক্ে ঩াযক্ফন। কায্ 
বখন Text wrap কযা আক্ছ। োই ছটফটা ইচ্ছাভক্ো ঳যাক্ে ঴ক্র আ঩নাক্ক format tab পর্ক্ক 
Text Wrap option পর্ক্ক In front of text অ঩঱নটা ট঳ক্রক্ট কযক্র ছটফটা খুফ বারবাক্ফ ভুব 
কযাক্ে ঩াযক্ফন। 
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আয পেখুন ছটফক্ে পম অ঩঱নগুক্রা আক্ছ প঳ই অ঩঱নগুক্রায কাজ পফাঝায জনয আ঩নাযা 
঱ব্দগুক্রায ফা রা অর্ড পেক্খ টনন। আ঱া কটয অ঩঱নগুক্রা বক্ক বক্ক ট঳ক্রক্ট কযক্রই আ঩নাযা 
বয কাজ ফুঝক্ে ঩াযক্ফন। 
টনক্চয ছটফক্ে রক্ষ করুন 
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বখাক্ন অক্নক অ঩঱ন আক্ছ মায ভাধযক্ভ আ঩নাযা টফটবন্ন কাজ কযক্ে ঩াযক্ফন। টনক্চ টকছু ফ্ডনা 
টেরাভ ফাটকটুকু আ঱া কটয আ঩নাযা কক্য টনক্ে ঩াযক্ফন। 
 
Adjust- বখান পর্ক্ক আ঩টন আ঩নায ছটফয colour, brightness, size ইেযাটে ঩টযফেডন কযক্ে 
঩াযক্ফন। 
shadow effect- বটা টেক্য় ছটফক্ে ছায়া টেক্ে ঩াযক্ফন। 
picture border- বটা টেক্য় ছটফয চায঩াক্঱ ফর্ডায পেয়া মায়। 
position- ছটফ টফটবন্ন জায়গায় যাখক্ে ঩াযক্ফন। 
bring to front- ছটফ ঳ফায উ঩ক্য আনায জনয পমভন েুটা ছটফয টবেক্য পকানটা উ঩ক্য র্াকক্ফ। 
send to back- পকান ছটফক্ক ঳ফায টনক্চ যাখায জনয 
text wrapping- আক্গই পেক্খক্ছন 
Align- বটাও আ঩নাযা জাক্নন 
Rotate- ছটফ পঘাযাক্নায জনয ফযফ঴ায কযা ঴য় 
crop- ছটফ ফাইক্য পর্ক্ক টকছু অ ঱ কাটায জনয 
ব঳ফ Effect পেয়ায জনয ছটফ ট঳ক্রক্ট কক্য পম পকান option ব টিক করুন বফ  ঩টযফেডন রক্ষ 
করুন। পমভন আটভ Rotate টা পটট কক্য পেখটছ। 
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প্রর্ক্ভ clip art click করুন 
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োয঩য র্ান ঩াক্঱ নেুন বকটট উইক্ন্ডা পেখক্ে ঩াক্ফন। clip organize clip ব টিক করুন 
(অক্নক্কয ব অ঩঱নটট organize clip option টট নাও র্াকক্ে ঩াক্য, কাযন আ঩টন office 
install কযায clip art install কক্যনটন োই) 

 

 

টনক্চয ভে উইক্ন্ডা আ঳ক্ফ। পম পকান folder select করুন টনক্চয ভে পেখক্ে ঩াক্ফন। 
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ছটফক্ে পেখাক্না স্থাক্ন টিক কক্য Copy করুন। 
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োয঩য বটট close কক্য টেন ও word document ব right click কক্য paste ব টিক করুন। 
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ো঴ক্রই clip art টট র্কুক্ভন্ট ব চক্র আ঳ক্ফ। 

 

আজ আভযা Insert Menu বয অন্তডগে Header & Footer পভনুয কাজ পেখফ। বটা খুফই 
গুরুত্ব঩ূ্ড কায্ ঳াধায্ে ভাটজডন বয টবেক্য পকান টকছু পরখায জনয বটা ফযফহৃে ঴য়। ভাটজডন বয 
টবেয ঳াধায্বাক্ফ পরখা মায় না। অফ঱য Text box ফযফ঴ায কক্য আ঩টন ভাটজডন বয টবেক্য 
টরখক্ে ঩াক্যন। টকন্তু header & footer অ঩঱ন ফযফ঴ায কযক্র page number গুক্রা প্রটে 
প঩ক্জ Automatic বাক্ফ change ঴ক্য় মায়, প্রটে প঩ক্জয টাইক্টর automatic বাক্ফ টনক্য় পনয় – 
ফায ফায পরখা রাক্গ না। বই঳ফ কাযক্্ header & footer অ঩঱ন ফযফ঴ায কযা অক্নক 
রাবজনক। 
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টনক্চয ছটফক্ে পেখুন header & footer বয অফস্থান ভাকড কক্য পেখাক্না ঴ক্য়ক্ছ। 
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Document প঴র্ায পমাগ কযায জনয Insert > Header ব টিক করুন। োয঩য টনক্চয ভে পভনু 
পেখা মাক্ফ। বখান পর্ক্ক ঩ছন্দভে ট঳ক্রক্ট করুন। বখাক্ন Preview পেয়া আক্ছ আ঱া কটয 
আ঩নাযা বয preview পেখক্রই ফুঝক্ে ঩াযক্ফন, পকান header টা আ঩নায প্রক্য়াজনীয়। 

hira
ctg

.blog
spot.

com



    

 
 
আটভ পমভন পেখুন colorful বকটা header ট঳ক্রক্ট কক্যটছ, পমটায় োটযখ ও document title 
পেয়ায অ঩঱ন আক্ছ। 
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বকইবাক্ফ Footer menu পে পমক্য় পম পকান footer select করুন। 
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পেখুন আটভ Blank three column পুটায ট঳ক্রক্ট কক্যটছ। বখাক্ন ইচ্ছা কযক্র আটভ টফটবন্ন 
ধযক্নয ের্য টেক্ে ঩াটয। hira
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Page number অ঩঱ন ব মান বখান পর্ক্কও আ঩টন ঳যা঳টয page no. টেক্ে ঩াযক্ফন। ছটফক্ে 
পেখুন আটভ Page margins > Accent Bar, Right ট঳ক্রক্ট কক্যটছ মায পক্র ছটফয ভে র্ান 
঩াক্঱ Page no. প঩ক্য়টছ। 
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আ঩টন মটে ঳ খযা টেক্য় page no. না চান, আ঩টন মটে চান পযাভান ঴যক্প আ঩নায প঩জ ন  ঴ক্ফ 
ফা প঩জ ন  ৫ পর্ক্ক শুরু ঴ক্ফ। প঳ক্ক্ষক্ত্র আ঩টন বই অ঩঱ক্ন পমক্ে ঩াক্যন। 
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ছটফক্ে পেখাক্না স্থাক্ন টিক কক্য আ঩টন আ঩নায ঩ছন্দভে Number format ট঳ক্রক্ট করুন। 
োয঩য টনক্চ পেখুন পমক্কান নাম্বায পর্ক্ক ফা ঩ূক্ফডয প঩জ ন  পর্ক্ক প঩জ নাম্বায শুরু কযায 
option আক্ছ। 
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বখন আভযা Insert পভনু বয Text toolbar বয টকছু অ ঱ পেখক্ফা। 

 
 
প্রর্ক্ভই আভযা Text box ফানাক্না ট঱খফ বয ঳ুটফধা ঴র বটট আ঩টন পম পকান স্থাক্ন যাখক্ে 
঩াযক্ফন। অক্নক ঳ভয় অক্নক টকছু আ঩টন আ঩নায কাটিে স্থাক্ন টনক্ে ঩াযক্ফন না প঳ক্ক্ষক্ত্র 
Text box ফযফ঴ায কযক্ে ঩াক্যন। 
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পটক্সট ফক্স দেটয ঴ওয়ায ঩য টনক্চয ভে পেখাক্ফ। 

 
 
ফর্ডায ঩ছন্দ না ঴ক্র টনক্চয ছটফক্ে পেখাক্না স্থাক্ন টিক কক্য ফর্ডাযটা ভুক্ছ টেক্ে ঩াক্যন। 
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আয বই ফর্ডাযটা টকন্তু Print কযায ঩য পেখা মায়না। 

 

 
 
োই পটক্সট ফক্স ফযফ঴ায কক্য অক্নক টকছু কযা মায়। 
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Quick Parts menu বয টেক্ক রক্ষ করুন, বখাক্ন অক্নক টকছু আক্ছ, মা দ্বাযা আ঩টন অক্নক 
টকছু খুফ দ্রুে কযক্ে ঩াযক্ফন। 

 
 
আ঱া কটয বখানকায অ঩঱নগুক্রা আ঩নাযা টিক কযক্রই ফুঝক্ে ঩াযক্ফন, পকানটা দ্বাযা টক ঴য়। 
আটভ পমভন পেক্খন Publish date ব টিক কক্যটছ। টনক্চয ভে পেখক্ে ঩াক্ফন। hira

ctg
.blog

spot.
com



    

 
 
বখান পর্ক্ক প্রক্য়াজন অনুমায়ী পর্ট ট঳ক্রক্ট করুন প঳টাই র্কুক্ভন্টব show কযক্ফ। 

আ঩নাক্েয টনশ্চয়ই ভক্ন আক্ছ, আটভ আ঩নাক্েয বকটা task টেক্য়টছরাভ(column work done 
by table), প঳টা মাক্েয কযক্ে ঳ভ঳যা ঴ক্য়ক্ছ োক্েয জনয আটভ ঐ কাজটট কক্য টেটচ্ছ, আ঱া কটয 
঩যফেডীক্ে আ঩নাযা টনক্জযাই কযক্ে ঩াযক্ফন। প্রর্ক্ভই টনক্চয ছটফয ভে Insert > Table পর্ক্ক 
১করাভ ও ৩পযা টফট঱ষ্ট বকটট পটটফর দেটয করুন। 

hira
ctg

.blog
spot.

com



    

 
 
োয঩য ২য় পযা ট঳ক্রক্ট কক্য, Right Click করুন ও Split Cells ব টিক করুন। 
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বখন টনক্চয ছটফয ভে Number of columns বয ঘক্য value ট঴ক্঳ক্ফ 2 টেন। ওক্ক করুন। 

 

 
 
বফায আ঩টন বই পটটফক্রয টবেয আ঩নায প্রক্য়াজনীয় Text গুক্রা টরখুন। 
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ছটফক্ে পেখুন বখক্না টকন্তু চায঩াক্঱য black border পেখা মাক্চ্ছ। োই আভাক্েয বই ফর্ডাযটা 
None কযক্ে ঴ক্ফ। বই ফর্ডায remove কযায জনয টনক্চয ছটফয ভে ঳িূ্ড পটটফরটা ট঳ক্রক্ট কক্য 
right click কক্য Border and shading ব টিক করুন। 

 
 
বফায আ঩নাক্েয ঳াভক্ন নেুন বকটা উইক্ন্ডা আ঳ক্ফ বখান পর্ক্ক None select করুন। 
Preview box ব পেখুন চায঩াক্঱য ফর্ডায পনই। ওক্ক করুন। hira

ctg
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বখন File > Print > Print Preview পে মান ো঴ক্র পেখক্ফন টনক্চয ভে পেখা মাক্ফ। 
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আয বটা পেক্খ পকউ ফরক্ে ঩াযক্ফনা পম আ঩টন বই কাজটা পটটফর ফযফ঴ায কক্য কক্যক্ছন নাটক 
করাভ ফযফ঴ায কক্য। বই বকই ধযক্নয কাজ টকন্তু আ঩নাযা Text box টেক্য়ও দেটয কযক্ে 
঩াযক্ফন। টক- টনক্জয ফুটদ্ধ টেক্য় দেটয কযক্ে ঩াযক্ফন পো? আ঱া কটয অফ঱যই ঩াযক্ফন। কায্ 
আক্গই ফক্রটছ পম Text box বভন বকটা element মা আ঩টন Microsoft Word Document 
বয পম পকান জায়গায় ফযফ঴ায কযক্ে ঩াযক্ফন। আয বটা ফযফ঴ায কযায ঩য ঩ূক্ফড পেখাক্না 
টনয়ভানুমায়ী Border None কক্য টেক্ফন ো঴ক্রই ঴ক্য় মাক্ফ। 
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বখন আভযা ওয়ার্ড বয WordArt option টা পেখক্ফা। বটা দ্বাযা অক্নক ঳ুন্দয কক্য পরখা মায়। 
বখাক্ন PreMade টকছু পটক্সট টাইর আক্ছ মা আ঩নাযা শুধুভাত্র ট঳ক্রক্ট কক্য ফযফ঴ায কযক্ে 
঩াযক্ফন। বটা দ্বাযা পরখায় টফটবন্ন ইক্পক্ট পেয়া মায়। আটভ আ঩নাক্েয বখাক্ন টকবাক্ফ পরখা শুরু 
কযক্ে ঴য় বটা পেখাফ আয ফাটক অ঩঱নগুক্রা টনক্জযা পচষ্টা কক্য ট঱ক্খ টনক্ে ঴ক্ফ। 
প্রর্ক্ভই Insert > Wordart ব মান ঩ছন্দভে বকটট টর্জাইন বয উ঩য টিক করুন। 

 

 
আ঩টন মা টরখক্ে চান, প঳টা ঩ক্যয উইক্ন্ডাক্ে টরখুন 
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ওক্ক করুন টনক্চয ভে পটক্সট ঩াক্ফন। 

 

োয঩য টনক্চয ছটফক্ে পেখাক্না স্থাক্ন Mouse টনন ও ছটফটট ফে করুন। 
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ো঴ক্র টনক্চয ভে ঩াক্ফন। 

 
 
বফায উ঩ক্যয ছটফক্ে পেখাক্না স্থাক্ন, Red point বয ভাঝখাক্ন পম ঩ক্য়ন্ট পেখা মাক্চ্ছ বয উ঩য 
আ঩নায Mouse Pointer টট টনন ও টনক্চয টেক্ক Drag করুন। বযকভ বকটট ছটফ পেখক্ে 
঩াক্ফন। 
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বখন আ঩টন মটে বই পরখায য  ঩টযফেডন কযক্ে চান ো঴ক্র পরখায উ঩য প্রর্ক্ভ Double Click 
করুন। পেখক্ফন Format পভনু ট঳ক্রক্ট ঴ক্য় টগক্য়ক্ছ। বফায পেখুন টনক্চ ছটফক্ে প্রক্য়াজনীয় অ঩঱ন 
গুক্রা ভাকড কক্য পেখাক্না ঴ক্য়ক্ছ। 
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Shape Fill – বটা দ্বাযা আ঩নাযা পরখায য  ঩টযফেডন কযক্ে ঩াযক্ফন। বছাোও পেখুন আক্যা 
অক্নক অ঩঱ন আক্ছ পমভন: Gradient, pattern, picture etc. 
Shape Outline – বটা দ্বাযা আ঩নাযা পরখায চায঩াক্঱ পম ফর্ডায ফা Outline র্াক্ক প঳টা 
঩টযফেডন কযক্ে ঩াযক্ফন। 
Change Shape – বটায ভাধযক্ভ পরখায টফটবন্ন প঱ক্঩ ঩টযনে কযক্ে ঩াযক্ফন পমভন ফৃত্ত, 
অটধফৃত্ত, উ঩ফৃত্ত, ট঩যাটভর্, ইেযাটে। 
Shadow Effects – বটায ভাধযক্ভ পরখায় টফটবন্ন ধযক্নয প঱র্ ফা ছায়া ইক্পক্ট পেয়া মায়। 
3-D Effects – বই ইক্পক্টটা টেক্য় আ঩টন খুফ ঳঴ক্জই আ঩নায Text পক 3d ফাটনক্য় পপরক্ে 
঩াক্যন। 
আ঩নাযা মটে বই অ঩঱ন ফা ইক্পক্ট গুক্রায ঳টিকবাক্ফ combination কযক্ে ঩াক্যন, ো঴ক্র 
আ঩নাক্েয আয পছাটখাট ইক্পক্ট বয জনয Photoshop ফা Illustrator ফযফ঴ায কযা রাগক্ফ না, 
আ঩নাযা ওয়ার্ড ফযফ঴ায কক্যই আ঩নাক্েয পছাটখাট ইক্পক্ট বয কাজগুক্রা প঳ক্য পপরক্ে ঩াযক্ফন। 
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বখন আটভ আ঩নাক্েয ms word ফযফ঴ায কক্য টকবাক্ফ Logo create কযা মায় ো পেখাফ। 
আভযা আক্গ পম঳ফ কাজ পেক্খটছ প঳গুক্রা টেক্য়ই আভযা বই পরাক্গাটা ফানাক্ে ঩াযক্ফ। আ঳ুন শুরু 
কটয: 
প্রর্ক্ভই Insert > Shapes পর্ক্ক পেখাক্না shape টা ট঳ক্রক্ট কটয। 
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োয঩য ভাউ঳ ঩ক্য়ন্টায ড্রাগ কক্য shapeটট দেটয কটয। 
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ছটফক্ে ভাকড কযা স্থানগুক্রাক্ে ভাউ঳ ঩ক্য়ন্টায টনন বফ  ভাউ঳ পচক্঩ ধক্য টফটবন্ন টেক্ক ড্রাগ করুন 
বফ  ঩টযফেডন রক্ষ করুন। 
ছটফক্ে আটভ বকটট কারায কক্যটছ Shape fill দ্বাযা hira

ctg
.blog

spot.
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োয঩য ঴রুে ঩ক্য়ন্টায ধক্য ভাউ঳ ঩ক্য়ন্টায টবেযকায টেক্ক ড্রাগ কযক্র বভন ঴ক্ফ 
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঳ফুজ ঩ক্য়ন্টায টেক্য় পম পকান shape rotate কযা মায় 
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বখন আভযা পরাক্গা ফানাক্নায আ঳র কাজ শুরু কযফ। প্রর্ক্ভই টনক্চ পেখাক্না প঱঩টা ট঳ক্রক্ট 
করুন। 
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Shapes fill টেক্য় কারায করুন 
 

 
োয঩য টনক্চয প঱঩টা create করুন 
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ভাকড কযা অ ঱গুক্রাক্ে ভাউ঳ ঩ক্য়ন্টায টনন বফ  বটট ফে করুন। hira
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ো঴ক্র বটট টনক্চয ছটফ ভে পেখক্ে ঴ক্ফ 
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বটাও বকটু কারায কক্য টনই,  
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বয঩য আ঩টন shape টটয উ঩য Mouse বয right button click করুন োয঩য add text 
option select করুন, টনক্চয ছটফ পেখুন  hira

ctg
.blog
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োয঩য Insert > word art ট঳ক্রক্ট করুন 
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টনক্চয ভে টরখুন (আ঩টন ইচ্ছা কযক্র font change কক্য টনক্ে ঩াক্যন পমভন আটভ kalpurush 
font টট select কক্যটছ)  

 
 
োয঩য আ঩টন shape fill পর্ক্ক রার কারায select করুন 
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আফায আক্গয ভে add text টেক্য় Word art select করুন 
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টনক্চয Text টুকু টরখুন 
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টনক্চয ছটফয ভে পগার প঱঩ টেন।  
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োয঩য আফায shapes পর্ক্ক বই প঱঩টট ট঳ক্রক্ট করুন। 
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Shape টটক্ক আভযা আভাক্েয পরাক্গায ভাঝখাক্ন ফট঳ক্য় shape fill select কটয  
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঳ফক্঱ক্ল আভাক্েয দেটয কযা পরাক্গাটট বভন পেখক্ে ঴ক্ফ। 
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আ঱া কটয আ঩নাক্েয বার পরক্গক্ছ। ববাক্ফ ms word ফযফ঴ায কক্য আক্যা অক্নক ঳ুন্দয কাজ 
কযা মায়। আ঩নাযাও বকটু পচষ্টা কযক্রই ঩াযক্ফন।  

বখন আটভ আ঩নাক্েয ms word বয খুফই গুরুত্ব঩ূ্ড বকটট কাজ পেখাক্ফা। আটভ বখন 
আ঩নাক্েয পম টুরটটয কাজ পেখাফ বয নাভ ঴র Equation বটা Insert menu বয টবেক্য 
঩াক্ফন। Equation অর্ড ফুঝক্েই ঩াযক্ছন, ঴যা বটা টেক্য় টফটবন্ন ধযক্নয Math টরখক্ে ঩াযক্ফন। 
অক্নক্কই math word ব টাই঩ কযায প্রক্য়াজন ঴ক্র drawing tool ফযফ঴ায কক্য ফা অনয 
঳পটওয়যায ফযফ঴ায কক্য। টকন্তু আ঩নাযা খুফ ঳঴ক্জই equation option ফযফ঴ায কক্য জটটর 
জটটর অ ক ও কক্িাজ কযক্ে ঩াযক্ফন পমভন- Matrices, Calculus, Limit, Function, 
Fourier series, Normal algebra equation and so on. 
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Equation টেক্য় কাজ কযা অক্নক ঳঴জ টকন্তু োয আক্গ আ঩নাক্ক বকটা কাজ কযক্ে ঴ক্ফ আয 
প঳টা ঴র পকান অ঩঱ন বয টবেয পকান অ ক বয symbol গুক্রা আক্ছ ো পেক্খ টনক্ে ঴ক্ফ। 
প্রর্ক্ভ অ ক্কয টেক্ক োকান বফ  টিক প঳ই যকভ পেখক্ে symbol টা equation menu পর্ক্ক 
select করুন োয঩য just click and type. 

আ঳ুন আটভ আ঩নাক্েয ঳ুটফধায জনয টকছু পভনুয screenshot টেটচ্ছ আয ফাটক পভনু গুক্রা 
আ঩নাক্েয টনজ োটয়ক্ত্ব পেক্খ টনক্ে ঴ক্ফ। 

 
 
টনক্চয ছটফক্ে পেখুন অক্নক ধযক্নয Template দেটয কযা আক্ছ। আ঩নায equation বয ঳াক্র্ 
বগুক্রা টভরক্র বগুক্রাও টিক কক্য ফযফ঴ায কযক্ে ঩াক্যন 
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পেখুন আটভ বকটট ট঳ক্রক্ট কক্যটছ। আ঩নাযা বটটক্ক ইচ্ছা কযক্র modify কযক্ে ঩াক্যন। 
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পেখুন equation tools বয design menu বয টবেয টফটবন্ন ধযক্নয প্রেীক পেয়া আক্ছ। 
বগুক্রাও ভাক্ঝ ভাক্ঝ ফযফ঴ায কযা রাগক্ে ঩াক্য। 

 
 
টনক্চয ছটফক্ে পেখুন বখাক্ন আক্যা অক্নক ধযক্নয symbol পেয়া আক্ছ, আ঩নাযা শুধুভাত্র বগুক্রায 
উ঩য click কক্য ফযফ঴ায কযক্ে ঩াযক্ফন 

 
 
Operator’s বয উ঩য টিক কযক্র বভন ছটফ আ঳ক্ফ। 
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োয঩য আফায পেখুন Fraction ব টিক কযক্র আভযা টকবাক্ফ ফা কে বাক্ফ বগ্া ঱ পরখা মায় ো 
show কযক্ছ। hira

ctg
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com



    

 
 
ববাক্ফই ফাটক অ঩঱নগুক্রা টিক কক্য পেখুন। 

বখন টনক্চয ছটফটা পেখুন আভযা বভন বকটা ভযাটিক্স দেটয কযক্ফা। 
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বটা দেটয কযায জনয টনক্চয ধা঩গুক্রা অনু঳য্ করুন 
উ঩ক্যয ছটফক্ে পেখুন ২ ঩াক্঱ ২ টা 3rd bracket আক্ছ োই প্রর্ক্ভই আভযা টনক্চয ছটফয ভে 
কক্য 3rd Bracket বয উ঩য টিক কযক্ফা। 
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টনক্চয ছটফয ভে ঴ক্ফ 
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োয঩য Matrix menu পর্ক্ক ৩ x ৩ empty matrix বয উ঩য টিক করুন 

 
 
োয঩য mouse টেক্য় টিক করুন ও keyboard পর্ক্ক প্রক্য়াজনীয় ঳ খযা টরখুন ো঴ক্রই ঴ক্য় 
মাক্ফ। 
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বফায আভযা টনক্চয ছটফয ভে function টট দেটয কযক্ফা। 

 
 
বজনয প্রর্ক্ভই আভযা Limit and Log পর্ক্ক ছটফক্ে পেখাক্না ৩ নম্বয অ঩঱নটা ট঳ক্রক্ট কটয। 
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োয঩য lim বয টনক্চয ঘক্য টিক কটয keyboard পর্ক্ক X টরটখ, োয঩য symbol পর্ক্ক 
arrow select কটয বফ  োয঩য 4 type কটয ো঴ক্র টনক্চয ভে ঴ক্ফ। 
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বখন পেখুন আভাক্েয অ ক্ক রফ ও ঴য ফা Numerator ও denominator আক্ছ োই আভযা 
ছটফয ভে বই টচহ্নটা ট঳ক্রক্ট কযক্ফা hira

ctg
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োয঩য উ঩ক্যয অ ক্঱ 3- টরটখ বফ  পভনু পর্ক্ক Root sign টা add কটয। 
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োয঩য x-5 টরটখ 
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োয঩য ঴ক্যয অ ক্঱ টিক কক্য x- টরটখ বফ  পভনু পর্ক্ক superscript option টা ট঳ক্রক্ট কটয। 
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োয঩য টিক কক্য 3 বফ  ২ টরটখ। ো঴ক্রই আভযা আভাক্েয প্রক্য়াজনীয় Equation টা প঩ক্য় 
মাফ। 

 
 

 

 

 
আভযা উ঩ক্যয বই ছটফটটয ভে type কযক্ফা। 
বজনয প্রর্ক্ভই ms word বয insert পভনুয equation পর্ক্ক ছটফয ভে Insert new 
equation ব টিক করুন। 
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োয঩য বভন আ঳ক্ফ 
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অ ক বয টেক্ক রক্ষ করুন বফ  ছটফয ভে Limit and Log menu পর্ক্ক বকই যকভ পেখক্ে 
Log select করুন 

 
 
োয঩য টনক্চয অ ক্঱ টিক করুন ও অঙ্ক পেক্খ টাই঩ করুন 

 
 
পরখা ঴ক্য় পগক্র ঳ভান টচহ্ন টেক্য় আফায Log টনক্য় আ঳ুন বফ  অ ক পেক্খ টাই঩ করুন 
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ো঴ক্রই টনক্চয ভে অ কটট টাই঩ কযা ঴ক্য় মাক্ফ। 

 

বফায আভযা টনক্চয ভে বকটট অ ক কক্িাজ কযক্ফা hira
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বজনয প্রর্ক্ভই অঙ্কটায টেক্ক বারভে রক্ষ করুন োয঩য large operator পর্ক্ক বকই যকভ 
পেখক্ে বকটট summation টচহ্ন টনন 
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োয঩য টিক ও টাই঩ করুন বফ  symbol পর্ক্ক Infinity ঳াইন ফ঳ান। hira
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োয঩য পমক্঴েু বগ্া ঱ আক্ছ, োই বকই যকভ পেখক্ে fraction sign টনন 
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টাই঩ করুন ও টনক্চ Script পর্ক্ক superscript select করুন 
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টাই঩ করুন ও Fraction টনন 
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ববাক্ফই complete equationটট টরক্খ পপরুন। 
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বখন আটভ আ঩নাক্েয ঳াক্র্ পম টফলয়টা প঱য়ায কযক্ফা োয নাভ ঴র Chart. আ঱া কটয আ঩নাযা 
঳ফাই চাক্টডয ফয঩াক্য কভ পফট঱ জাক্নন। চাটড টেক্য় ঳াধাযনে পম পকান ধযক্নয র্াটা খুফই ঳঴জ 
বাক্ফ উ঩স্থা঩ন কযা মায়, পক্র পম পকউ চাটড পেক্খই পরাপর ঳঴ক্জ ফুঝক্ে ঩াক্য। কাযন 
঳াধাযনে আভযা পটটফক্রয ভাধযক্ভ আভাক্েয টফটবন্ন ধযক্নয র্াটা উ঩স্থা঩ন কটয, টকন্তু ো চাক্টডয 
঳া঴াক্ময উ঩স্থা঩ন কযক্র বকই঳াক্র্ ঳঴জক্ফাধয ও েৃটষ্টনন্দন ঴য়। চরুন আভযা টকবাক্ফ চাটড দেটয 
কযফ ো ধাক্঩ ধাক্঩ পেক্খ টনই। আভযা টনক্চয পটটফরটায টেক্ক রক্ষ কটয পমখাক্ন ফরা আক্ছ 

 

প্রটে ১০০ জন ভানুল বয টবেয ৪৫ জন ঩ুরুল ও ৫৫ জন ভট঴রা আক্ছ, বটাক্ক মটে আভযা pie 
চাক্টডয ঳া঴াময represent কটয ো঴ক্র বভন পেখাক্ফ: 
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বখন বযকভ বকটট চাটড দেটযয জনয প্রর্ক্ভ Insert menu পর্ক্ক chart option ব টিক করুন। 
টনক্চয ভে উইক্ন্ডা আ঳ক্ফ বখান পর্ক্ক পম পকান বকটা Pie chart ট঳ক্রক্ট করুন বফ  ওক্ক 
করুন। 
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োয঩য টনক্চয ভে পেখক্ফন excel ও open ঴ক্ফ। আভযা পমক্঴েু পম পটটফরটা দেটয কযক্ে চাটচ্ছ, 
প঳টায ভে কক্য excel ব বকই যকভবাক্ফ টরটখ। hira
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োয঩য টনক্চয ছটফক্ে পেখাক্না স্থাক্ন টিক ও ড্রাগ কক্য আভাক্েয প্রক্য়াজনীয় র্াটা ট঳ক্রক্ট কটয 
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঳ফক্঱ক্ল পটটফরটট বভন পেখক্ে ঴ক্ফ। 
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ইচ্ছা কযক্র বখন excel close কক্য টেক্ে ঩াক্যন। 
োয঩য chart style change কযক্ে চাইক্র 

 
 
ছটফক্ে পেখাক্না পভনুক্ে টিক কযক্র টনক্চয ভে অক্নক চাটড পেখক্ে ঩াক্ফন, বখান পর্ক্ক ঩ছন্দ ভে 
বকটা ট঳ক্রক্ট করুন 
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োয঩য চাক্টডয layout change কযক্ে চাইক্র টনক্চয পভনুক্ে মান, ভাকড কযা অ ক্঱ টিক করুন। 

 
পেখুন বকেভ প্রর্ভটা ট঳ক্রক্ট কক্য টেক্র, চাটড বয ইনপযক্ভ঱নগুক্রা অক্নক ঳ুন্দয বাক্ফ show 
কযক্ছ। 
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মটে আ঩নায pie chart ঩ছন্দ না ঴য় ো঴ক্র টনক্চয ছটফয ভে change chart types ব টিক 
করুন বভন উইক্ন্ডা আ঳ক্ফ ঩ছন্দভে বকটা chart ট঳ক্রক্ট করুন। 

 
 
োয঩য ok কযক্র পেখক্ফন pie chart ঩টযফেডন ঴ক্য় column chart ব ঩টযফেডন ঴ক্য় টগক্য়ক্ছ। 
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বখন আভযা chart টনক্য় আযও কাজ কযফ। আবার Insert menu পর্ক্ক chart বয উ঩য টিক 
করুন। টনক্চয ভে পেখক্ে ঩াক্ফন। 
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োয঩য ওক্ক কযক্রই টনক্চয ভে word ও excel বকই ঳াক্র্ পেখক্ে ঩াক্ফন। আভযা বখান 
পর্ক্ক Data গুক্রা change কক্য টেক্ফা। 

 
টনক্চয ভে Data পেফ। বখাক্ন ধক্য টনন SSC ও HSC বয ২০১০, ২০১১ ও ২০১২ ঳াক্রয ঩াক্঳য 
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঴ায পেয়া আক্ছ মা আভযা Chart আকাক্য পেখফ 

 
 

র্াটা entry ঴ক্য় পগক্র excel close কটয। তাহলে microsoft word ব বভন পেখা মাক্ফ। 

 
উ঩ক্যয ছটফয টেক্ক রক্ষ করুন। ব ছটফটট পেখক্রই আ঩টন র্াটা গুক্রা টফক্েল্ না কক্যই ঳যা঳টয 
ফক্র টেক্ে ঩াযক্ফন পকান ফছয SSC ফা HSC বয ঩াক্঱য ঴ায বাক্রা টছর। চাটড বইটা ফে বকটা 
঳ুটফধা ঳ফ টকছু খুফ ঳঴ক্জই পফাঝা মায়। hira
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উ঩ক্যয ছটফক্ে পেখুন। চাটডটট ট঳ক্রক্ট র্াকা অফস্থায় পভনু পর্ক্ক Layout অ঩঱ন ট঳ক্রক্ট করুন। 
োয঩য টনক্চয ছটফয ভে Chart Title পর্ক্ক চাটড বয Title পেন। 
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োয঩য আফায Data Tables বয under পর্ক্ক Center ট঳ক্রক্ট করুন ো঴ক্র প্রক্েযকটা ফাক্যয 
ভান পেখা মাক্ফ। 
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র্াটা পটটফর পর্ক্ক টনক্চয অ঩঱নটা ট঳ক্রক্ট করুন। ো঴ক্র টনক্চয ভে র্াটা পটটফর পমাগ ঴ক্য় 
মাক্ফ। 

hira
ctg

.blog
spot.

com



    

 
োয঩য chart select কক্য design পভনুক্ে মান, অনয Chart layout select করুন, পেখুন 
chart অনযযকভ পেখা মাক্চ্ছ 
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আফায chart styles পর্ক্ক চাটড বয ফায গুক্রায style অনয যকভ ৩ টর্ ইক্পক্ট টেক্ে ঩াক্যন hira
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Change Chart Type অ঩঱ন ব মান। 
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Bar chart পর্ক্ক পম পকান বকটা select করুন। 
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বই টছর পভাটাভুটট চাটড ঳িটকডে কাজ।  

বখন আভযা Insert menu বয smart art options বয কাজ পেখক্ফা।  

hira
ctg

.blog
spot.

com



    

 
 
প্রর্ক্ভই আ঩নাযা smart art ব টিক কযক্র বখাক্ন প্রচুয ঩টযভাক্ন smart art বয পটভক্েট 
পেখক্ে ঩াক্ফন। অক্নক ধযক্নয Hierarchy ফা Relationship ছটফয ভাধযক্ভ পেখাক্নায জনয 
টফটবন্ন ধযক্নয টর্জাইন আক্গ পর্ক্ক কযা আক্ছ, মা আ঩নাযা শুধুভাত্র টিক কক্যই দেটয কযক্ে 
঩াযক্ফন। আটভ আ঩নাক্েয বকটা hierarchy দেটয কক্য পেখাক্ফা বফ  আ঱া কযক্ফা ফাটকগুক্রা 
আ঩নাযা টনক্জযা পচষ্টা কক্য ট঱খক্ফন। 
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উ঩ক্যয ছটফয ভে ট঳ক্রক্ট কক্য ok করুন। 
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উ঩ক্যয ছটফয ভে আ঳ক্ফ। উ঩ক্যয ছটফক্ে পমখাক্ন text পরখা আক্ছ প঳খাক্ন আ঩টন টিক কক্য জা 
ইচ্ছা টরখুন। 
আটভ টরখায ঩য টনক্চয ভে পেখাক্ফ 

 
 
আযক্মগুক্রা েযকায পনই, প঳গুক্রা ভাউ঳ টেক্য় ট঳ক্রক্ট কক্য। Delete press করুন টকক্ফার্ড পর্ক্ক।  
 
োয঩য টনক্চ আক্যা shape পমাক্গয জনয প্রর্ক্ভ পাক্ভডট঳ পরখা ফক্সটট ট঳ক্রক্ট কক্য menu পর্ক্ক 
add shape click করুন। টনক্চয ছটফয ভে নেুন ফক্স আ঳ক্ফ। 
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Right Click কক্য Edit Text পর্ক্ক পরখা ঩াল্টাক্ে ঩াক্যন ফা অনয টকছু টরখক্ে ঩াক্যন। 

 
 
কারায ঩টযফেডন বয েযকায ঴ক্র পম পকান ফক্স ট঳ক্রক্ট কক্য উ঩ক্যয পভনু পর্ক্ক অনয যঙ টনফডাচন 
করুন। 
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ো঴ক্র আভাক্েয hierarchy টট টনক্চয ভে ঴ক্ফ 

 
আ঩টন মটে hierarchy বয layout ঩টযফেডন চান ো঴ক্র অনয Layout পকভন রাগক্ফ ো select 
কক্য পেক্খ টনক্ে ঩াক্যন। 
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আ঱া কটয ফুঝক্ে পকান ঳ভ঳যা ঴য়টন। আয ফাটক Smart Art বয পটভক্েট গুক্রা আ঩নাযা বক্ক 
বক্ক টনক্জযা পচষ্টা করুন। আয পম পকাক্না layout ট঳ক্রক্ট কযায ঩য কাজ কযায ঩দ্ধটে প্রায় 
বকই যকভ। 

 

ভাইক্রা঳পট ওয়ার্ড টেক্য় টফটবন্ন ধযক্নয কাজকভড কযা মায়। মা ঴য়ে আভযা অক্নক্কই জাটননা। 
আভায টকন্তু ms word খুফই টপ্রয় বকটা ঳পটওয়যায। অফ঱য শুধু ms word ফরক্র বুর ঴ক্ফ। 
আটভ MS OFFICE PACKAGE টাক্ক খুফই ঩ছন্দ কটয। আটভ অফ঱য বটা ফরক্ফা না পম, আটভ পম 
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কাজ গুক্রা পেখারাভ বইগুক্রাই ঳ফ ফা বই গুক্রা আ঩নাযা আয অনয পকার্াও ঩াক্ফন না, েক্ফ বটা 
ফরক্ফা পকউ মটে বই কাজগুক্রাই বারবাক্ফ আয়ে কযক্ে ঩াক্যন ো঴ক্র োয আয Microsoft 
word বয অনয পকান কাজ জানায েযকায পনই। আয আ঩টন মটে ms word বয basic tools 
গুক্রায কাজ বারবাক্ফ জাক্নন ো঴ক্র আ঩টন Excel, Access, Powerpoint ইেযাটে 
঳পটগুক্রাক্েও অক্নক বটগক্য় র্াকক্রন। কাযন বগুক্রায formatting, styles ইেযাটে বকই 
যকভ। েক্ফ আটভ আ঩নাক্েয আক্যা অক্নক কাজ আক্ছ পমগুক্রা পেখাক্ে ঩াযরাভ না ফক্র েুঃটখে। 

েক্ফ Mailings, References & Review Tab গুরা বার কক্য পেখক্র, আ঩নাযা টনক্জই বক্েয 
কাজ গুক্রা ফুঝক্ে ঩াযক্ফন। পমভন Review Tab ব আ঩টন ঩াক্ফন আ঩নায পরখাক্ে 
Gramartical পকান বুর র্াকক্র আ঩টন প঳খান পর্ক্ক টিক কযক্ে ঩াযক্ফন।  

বে েীঘড ঳ভয় ধক্য ফইটট ঩োয জনয আ঩নাক্ক ধনযফাে। 

(঳কর প্রকায অটনচ্ছাকৃে বুর ও অ঩াযেট঱ডো প঴েু অস্বচ্ছোয জনয ক্ষভা পচক্য় টনটচ্ছ। গু্ীজন টনজ 

গুক্নই আভায বুরগুটর ক্ষভা঳ুন্দয েৃটষ্টক্ে পেখক্ফন ব আ঱াই যইর। ধনযফাে বার র্াকক্ফন ঳কক্র)  

(ইন্টাযক্নট ঴ক্ে ঳ গৃ঴ীে) 
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